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Dr.Explain overview
 
 

With Dr.Explain you can easily create help documentation both for desktop and web
applications that are made in any programming language, IDE, or UI framework
 
Dr.Explain captures windows from live applications or websites and automatically recognizes
application controls. The program automatically creates annotated screenshots with numbered
callouts and tags. In comparison with other help authoring tools, this unique technology allows for
writing documentation for applications with comprehensive user interfaces much faster.

The most effective way to create help files, online manuals, and printable documentation
 
Manage text content, technical illustrations and annotated screenshots with ease. Flexibly set up
your documentation layout, help topics, and content structure. Embed support for keyword indexes
and full text search capabilities without programming or server side scripting. Link help topics with
application modules to create context sensitive help files.
 
Dr.Explain generates multiple output help formats from a single source
 
Use one source and one tool to create standalone help files, online manuals, or printable
documentation for your software systems. Generate online manuals with search capabilities without
programming, databases, or server side scripting. Compile Microsoft HTML Help files in CHM format
to ship with your application. Make printable and cross-platform documentation in RTF and PDF
formats.
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Getting started
 

This section contains information on how to install, configure, and register your copy of Dr.Explain.
You will also learn its main features and functions — all you need in order to start creating
professional CHM, HTML, PDF, and RTF manuals.
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Quick Overview
 

This section contains a quick overview of Dr.Explain software, lists system requirements and
credits.
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About Dr.Explain
 

Dr.Explain is a professional help authoring tool combining lots of useful features that make the
process of creating technical documentation easy and effortless — be it documentation for a
desktop or web application. Dr.Explain is a good choice for any software vendor, from ISV and
freelancers to big software development companies and studios.
 
Its main features such as screen capturing and automatic creation of annotations for screenshots
make it stand out among other documentation tools. From one single source, you will be able to
output your documentation to HTML, CHM, RTF, or PDF format.
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System Requirements
 

Dr.Explain has the following minimum system requirements:
 

•  Hardware: 1GHz CPU, 512 MB RAM, 200 MB of free space on HDD
•  OS: The following OS configurations are supported:

MS Windows XP 32 bit with SP3, with MSXML6, with Internet Explorer 8 (or higher)
MS Windows XP 64 bit with SP2, with MSXML6, with Internet Explorer 8 (or higher)
MS Windows Server 2003
MS Windows Server 2008
MS Windows Server 2012
MS Windows Vista
MS Windows 7
MS Windows 8
MS Windows 8.1
MS Windows 10

https://www.microsoft.com/en-us/download/details.aspx?id=24
https://www.microsoft.com/en-us/download/details.aspx?id=3988
http://www.microsoft.com/en-us/download/internet-explorer-8-details.aspx
https://www.microsoft.com/en-us/download/details.aspx?id=17791
https://www.microsoft.com/en-us/download/details.aspx?id=3988
http://www.microsoft.com/en-us/download/internet-explorer-8-details.aspx


Dr.Explain 4.10 : User Guide Credits

Copyright (c) Indigo Byte Systems, LLC 10 of 259

Credits
 

Dr.Explain reuses the following third-party free components that require disclosure:
 
 
Anti-Grain Geometry Library, available at http://www.antigrain.com/ and licensed under an AGG
License (http://www.antigrain.com/license/index.html)
 
Anti-Grain Geometry - Version 2.4
Copyright (C) 2002-2004 Maxim Shemanarev (McSeem)
Permission to copy, use, modify, sell and distribute this software is granted providing this copyright notice appears in all
copies.
This software is provided "as is" without an express or implied warranty, and with no claim as to its suitability for any
purpose.
 
 
Crypto++ Library 5.5.2, available at http://www.cryptopp.com/ and is licensed under the following
license http://www.cryptopp.com/License.txt
 
Compilation Copyright (c) 1995-2010 by Wei Dai. All rights reserved.
Permission to use, copy, modify, and distribute this compilation for any purpose, including commercial applications, is
hereby granted without a fee, subject to Crypto++ Library 5.5.2 license restrictions.
 
 
Compact language detector, available at http://code.google.com/p/chromium-compact-language-
detector/ and is licensed under the following license:
 
Copyright (c) 2010 The Chromium Authors. All rights reserved.
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:
 
   * Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.
   * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.
   * Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.
 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
 
The Chromium Authors.
 
- Michael McCandless <lucene at mikemccandless.com> Maintainer.
- Alberto Simões <hashashin at gmail.com> Debian/kFreeBSD support.

http://www.antigrain.com/
http://www.antigrain.com/license/index.html#toc0002
http://www.cryptopp.com/
http://www.cryptopp.com/License.txt
http://code.google.com/p/chromium-compact-language-detector/
http://code.google.com/p/chromium-compact-language-detector/
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- Jehan <jehan at mygengo.com> Packaging (Makefile, pkg-config, libtool).
 
ICU 1.8.1 and later, available at http://www.icu-project.org/ and is licensed under the following
license:
 
Copyright (c) 1995-2015 International Business Machines Corporation and others. All rights reserved. 
 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom
the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in
all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting
documentation.
 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS
INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER
IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
 
Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to
promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.
 

http://www.icu-project.org/
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Contacts
 

Product website
Additional information and the contact form are available on the Dr.Explain website:
www.drexplain.com

 
E-mail

Dr.Explain Technical Support: support@drexplain.com
Ordering and Licensing Issues: order@drexplain.com
General Requests: info@drexplain.com

 
Forum

You may post your ideas or questions on the Dr.Explain Discussion Forum.

http://www.drexplain.com
mailto:support@drexplain.com
mailto:order@drexplain.com
mailto:info@drexplain.com
http://www.drexplain.com/forum/
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Installation
 

Please follow these instructions to install Dr.Explain on your PC:

1.  Download the latest installation package from the Dr.Explain website: http://
www.drexplain.com/download/ and save it to your computer.

2.  Extract setup.exe from the downloaded archive. Use WinZip or another archiving utility.

3.  Run setup.exe and follow the instructions. If you plan to create PDF files with Dr.Explain
then you need to agree to install Java Runtime Environment. You don't need to uninstall the
previous version.

4.  Run Dr.Explain once the installation is finished.

By default, Dr.Explain is installed to C:\Program Files\DrExplain on 32-bit operating systems and
to C:\Program Files (x86)\DrExplain on 64-bit ones.

Note: On Windows 7 or later you might be required to run the setup.exe as the Administrator.

http://www.drexplain.com/download/
http://www.drexplain.com/download/
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Full Version Advantages
 

Trial limitations

The free demo mode allows you to create projects of any size. So you may try all the capabilities
of Dr.Explain for free.

All output images in the free mode are watermarked. Some productivity boost functions are also
locked in the free mode. A paid license key is required to remove image watermarks and unlock
protected functions.

Licensing model

Dr.Explain is licensed under a per-user model. There are no support or annual fees.

All minor updates (e.g. 5.x) are free. Major updates may be paid for those who ordered a license
more than 12 months ago.

More information about licensing: http://www.drexplain.com/ordering_faq/

License types

There are three types of licenses: Regular, Advanced and Ultima.

An Advanced License enables advanced functions that boost productivity when working with large
and complex projects. Also, Advanced license allows you to generate PDF files and use JavaScripts
in your online help. By using the Advanced license you will be able to use the full features of online
help tools like full text search in online manuals, keyword indexes, pages print preview, pop-up
tooltips and other tools. See the table below for more details.

Advanced License allows you to use advanced features that speed up the process of help authoring.
Advanced features are most helpful for large projects with many nesting and cross-linked topics,
many illustrations and annotated screenshots.

The Ultima license allows multiple Dr.Explain users to work together on the same  projects via
tiwri.com platform.

The following table lists the difference between the Free, Regular, Advanced, and Ultima version of
Dr.Explain:

Compare the licenses
 

 Free Trial Regular Advanced Ultima

HTML output Watermarks on images + + +

RTF output Watermarks on images + + +

CHM output Watermarks on images + + +
PDF output Watermarks on images Watermarks on images + +

http://www.drexplain.com/ordering_faq/
http://www.tiwri.com
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Search
in online manuals Search result titles are trimmed Search result titles are trimmed + +
Keyword indexes
in on-line manuals Keyword titles are trimmed Keyword titles are trimmed + +

Tree-like menu
in online manuals

Menu item titles on

second level are trimmed

Menu item titles on

second level are trimmed
+ +

Print versions of pages
in online manuals

The content is replaced

with  watermark

The content is replaced

with watermark
+ +

Pop-up tooltips
over screenshots

The content is replaced

with watermark

The content is replaced

with watermark
+ +

Validation tool   + +

Compacting tool   + +

Command line mode   + +

Google sitemap generator   + +

Teamwork via tiwri.com    +
 
  Order Order Order

 
 

http://www.tiwri.com
http://www.drexplain.com/order/
http://www.drexplain.com/order/
http://www.drexplain.com/order/
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Registration & Updating
 

Dr.Explain is licensed under a per-user model. You may choose a license bundle that suits your
needs at http://www.drexplain.com/order.

To proceed to the order form, just select an appropriate pack from those listed on our website and pay
by any method convenient for you. You will receive a confirmation message with your license key.

Once you have received your license key, please enter it in the Registration & Activation Dialog.

To update your version of Dr.Explain, download it from http://www.drexplain.com/download/ and run
the setup.exe file as described in the Installation section. You do not need to uninstall the previous
version of the software.

http://www.drexplain.com/order/?ref=help
http://www.drexplain.com/download/
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Registration & Activation Dialog
 

To be able to register your copy of Dr.Explain and to activate a license key, go to Help and click
Register Dr.Explain. The application will display the Activation dialog, where you must provide your
registration details to complete the registration and license activation process. After you complete
the license activation, you will switch to the licensed mode.

Name field

Specify your full name in the Licensed to: input field. It must be the same name that you
have provided in the order form.

Key field

Copy and paste your license key in this field.

Order ID field
Copy and paste your order reference
number in this field as it appears in the

order form.
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Activation type

The registration process includes license activation step. The license key is activated
remotely on Dr.Explain server.
 
If you choose Online activation then the process will be completed automatically via active
Internet connection.
 
If you have no active Internet connection on the computer then you can switch to By email
activation:

In this case, you must send the verification string to activation@drexplain.com from any
available computer with email software and then enter the response into the Activation key
field of the dialog to complete the license activation process.

Activate button

 
Click the Activate button to submit the registration information and to activate the license
in the certain copy of Dr.Explain.

Note: You might need to restart Dr.Explain to complete the registration process.

Cancel button

 
Click this button to discard the changes and close the dialog.
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Application Main Window
 

The main window of Dr.Explain allows you to manage your project elements. In this window, you may
create new projects, add new elements and manage application options and project settings.
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Main Toolbar

  Dr.Explain's main toolbar provides quick access to the key functions of Dr.Explain:
 

• 
 

 — click this button to create a new project.

• 
 

 — click this button to open an existent project.

• 
 

 — click this button to save the current project.

• 
 

 — click this button to commit all changes to the server when working with a shared
project.

• 
 

 — click this button to update the project and to retrieve changes from the server
when working with a shared project.
 

• 
 

 — is the main button of Dr.Explain. Click it to capture a new window, parse its
structure and add a new window screenshot and all its control references to the project. See
section Capturing Screen for more details. Drop-down menu allows you to add a screenshot
from a saved graphical file or clipboard.

• 
 

 — click this button to insert a new topic page or import external files into the project.

• 
 

 — click this button to cut the selected element from the project tree or text and copy
it to the application's clipboard.

• 
 

 — click this button to copy the selected element in the project tree or text into the
application's clipboard.

• 
 

 — click this button to paste the element from the clipboard into the project's tree or
content editor.
 

• 
 

 — click this button to export the current project into HTML Help.

• 
 

 — click this button to export the current project into CHM File.

• 
 

 — click this button to export the current project into RTF File.

• 
 

 — click this button to export the current project into PDF File.

• 
 

 — click this button to configure options for your current project. See chapter Project
Settings for more details.

• 
 

 — click this button to display information about Dr.Explain and registration details.
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Mode Tabs

Tab control allows you to easily switch between Editing and Preview modes. See section HTML,
CHM and PDF Preview for more details.

Content Editor

 
This is the main workspace of Dr.Explain. It allows you to edit topic content in WYSIWYG style. See
chapter Editing Content for more details.
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Project Tree

Tree view displays the structure of your project and allows you to quickly navigate through the
project's elements: topics and screenshot pages.

Use the pop-up menu to add new elements to your project, rename, delete, disable or rearrange
nodes.

Use Ctrl+Up and Ctrl+Down  keyboard shortcuts to change the order of sibling nodes in section.

Properties/ Keywords List Pane

This pane allows you to manage topic properties and keyword index list.

Status Bar

 
It shows status and progress of the operations being performed. The status bar also displays hints
for toolbar buttons and menu items when you point your cursor at them.
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Application & Language Settings
 

This section contains details on application settings and how to change the language of the
application.
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Application Settings Window
 

In the Application settings window, you can configure the global settings for Dr.Explain. To open
the application settings window, go to Options and click the Application settings... menu option.
You will see the following window:
 

Splash screen

Clear this check box if you do not want the splash screen to appear each time you start
Dr.Explain.

Start-up Dialog

Clear this check box if you want to turn off the project selection dialog on start-up. If this
option is turned off, Dr.Explain will open the most recent project by default.

Capturing Scenario Folder

In this section, you can set the path to the capturing scenario folder. Click the Browse
button to set a new path. Click Go To to display the current scenario folder in Windows
Explorer. For more details on capturing scenarios, see the Screen Capturing Settings
section.
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Java Bin folder

In this section, you can set the path to Java binaries which are required to create PDF files
and to capture Java Swing application screenshots.

Swing Capturing Assistant

To capture Java applications Dr.Explain requires the Java Swing Capturing Assistant. The
Assistant is a simple JAR file that must be put in your Java Home folder.
It will assist Dr.Explain by providing information about Swing GUI components lying under
the mouse pointer.
Use the corresponding button to install or uninstall Java Swing Capturing Assistant.

OK button

Click OK to save your changes.

Cancel button

Click Cancel to discard your changes.
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Application Language Window
 

In the Application Language... window, you can set the language for your copy of Dr.Explain.
To open the application language window, go to Options and click the Application Language...
menu option. The following dialog is displayed:
 

Supported Languages

This list displays all available languages for Dr.Explain.

OK button

After you selected the necessary language from the list, click OK to apply it.
 

Note: You need to restart Dr.Explain for the changes to take effect.
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Creating project
 

This section contains quick tutorials to help you start working with Dr.Explain. It contains steps on
creating new projects, opening recent projects, importing existing documentation from other sources,
saving your project and explains how to work with multiple projects.
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Startup Dialog

Each time you launch Dr.Explain, the application by default shows the startup dialog that allows you
to create a new project, import an existing document or to open a recent project:

Note: You can turn off the startup Dialog in Application Settings Window.
 

Create a new local project

Select this option button to start working on a new local project.

Create a new shared project

Select this option button to create new shared project on tiwri.com server.

http://www.tiwri.com
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Checkout a shared project

Select this option button to open a shared project from tiwri.com server.

Import files

Select this option button to import documentation from external files. Import Dialog should
appear.

Open existing project

Select this option button to open an existing project from file.

List

This section contains the list of recent projects. Shared projects are marked with blue
color.
Click the project you wish to open.

OK button

Press this button to skip the dialog and to create a new local project.

http://www.tiwri.com
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Creating New Project
 

To create a new local project, you can:

•  use the startup dialog;

• 
 
click the  button;

•  go to the File menu and click the Create a local project command;
•  use Ctrl+N keyboard shortcut.

To create a new shared project, you can:

•  use the startup dialog;
•  go to the File menu and click the Create a shared project on tiwri.com command.

Then, you can start adding new topics and window screenshot pages to the project.

After you finished adding your topics, do not forget to save your project.
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Opening Project
 

To open your existing project:

• 
 
click the  button;

•  go to File -> Open... ;
•  use the Ctrl+O keyboard shortcut;
•  select the appropriate option button in the startup dialog.

 
Once you choose to open an existing project, the standard Windows Explorer dialog appears
allowing you to locate the necessary file on your computer.
 
All projects are stored as .GUI files associated with Dr.Explain. You can also double-click the
necessary project file in Windows Explorer or your file manager to open it in Dr.Explain for editing.
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Import Dialog
 

By using the Import function you can import existing documentation to your Dr.Explain projects
and later publish it in the required format.
 
There are several ways to bring up the Import dialog:
 

•  in Dr.Explain, launch via the Startup Dialog;
•  go to the File menu and select the Import... menu option;
•  if you want to add an external file after a certain TOC topic, right-click the necessary
topic, go to the Add... menu option and then choose the Import external files... menu
option or use Alt+Shift+I shortcut.

 
After you select the Import... option, the following dialog appears:
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List

This window lists all types of supported file formats  that can be imported to Dr.Explain.
 

Select the file format that you would like to import to your documentation. Go to the
corresponding topic later on in this document to know the details on how to import each
supported file format.

Files location

This section allows you to set the path to the folder from which the files will be imported.

Click the  button to browse for the necessary files on your computer. A standard
Windows explorer window appears allowing you to select the appropriate files on your
computer.

Next button

Click this button to proceed with the import process after you have specified the files you
want to import.

Cancel button

Click the Cancel button to close the Import dialog.
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Import CHM
 

This section guides you through the process of importing compiled HTML Help (CHM) files to your
projects.
 
To import a CHM file to your project, select the corresponding file type (CHM) in the Select import
type list, locate the necessary file on your computer and click the Next button as shown in the
screenshot below:

 

 
After you click the Next button, Dr.Explain will start processing your CHM file. It will show
processing progress and display the results in a separate window:
 



Dr.Explain 4.10 : User Guide Import CHM

Copyright (c) Indigo Byte Systems, LLC 35 of 259

 
Click the OK button to close this window and start working on imported data in Dr.Explain.
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Import Folder with Files (HTML, TXT, XML)
 
This section guides you through the process of importing a folder with files on your computer
(.html, .txt, .xml) to your projects.
 
To import a folder with files to your project, select the corresponding import option in the Select
import type list, browse the necessary folder on your computer and click the Next button as
shown on the screenshot below:
 

 
After you click the Next button, Dr.Explain will start processing the specified folder. It will show the
processing progress and display the results in a separate window:
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Click the OK button to close this window and start working on imported data in Dr.Explain.
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Import Standalone HTML File
 

This section guides you through the process of importing a single HTML file on your computer to
your project.
 
To import an HTML file to your project, select the corresponding import option in the Select import
type list, locate the necessary file on your computer and click the Next button as shown on the
screenshot below:
 

 
After you click the Next button, Dr.Explain will start processing your html file. It will show the
processing progress and display the results in a separate window:
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Click the OK button to close this window and start working on the imported data in Dr.Explain.
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Import HLP
 

This section guides you through the process of importing a single HLP file on your computer to
your project.
 
To import an HLP file to your project, select the corresponding import option in the Select import
type list, locate the necessary file on your computer and click the Next button as shown in the
screenshot below:
 

 
After you click the Next button, Dr.Explain will start processing your HLP file. It will show the
processing progress and display the results in a separate window:
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Click the OK button to close this window and start working on imported data in Dr.Explain.
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Import RTF
 

This section guides you through the process of importing an RTF document to your project.
 
To import an RTF file to your project, select the corresponding import option in the Select import
type list, locate the necessary file on your computer and click the Next button as shown in the
screenshot below:
 

 
After you click the Next button, Dr.Explain will display Documents Styles Matching Dialog.
 
After you have configured document matching styles, click the OK button to continue.
 
Dr.Explain will start processing your rtf file. It will show the progress and display the results in a
separate window:
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Click the OK button to close this window and start working on imported data in Dr.Explain.
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Document Styles Matching Dialog
 

This dialog allows you to match the document formatting styles to the nesting levels of topics by
moving the necessary style or level to the corresponding side of the table.
 

RTF Document Styles list

This list displays all document styles found in the
selected RTF document.
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Topic Nesting Levels list

 This list shows all available topic nesting levels.

Move buttons

 Use these buttons to move the selected style(s) or level(s) from one list to the other.

Document Style Preview

 Shows the preview of the selected document style and
displays the font settings.

Nesting Level Preview

 Shows the preview of the selected nesting level style
and displays font settings.

Page Break check

If you clear this check box, Dr.Explain will consider
each page break in the specified RTF document as a topic's end.

OK button

  Click this button to save the changes and close the window. Import of RTF
document will be started.
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Reset button

 Click this button to discard all the changes you have made. This will reset the
window to the default settings and keep the window open.

Cancel button

 Click this button to discard the changes and close the window. Import will be
cancelled.
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Import Microsoft Word File
 

This section guides you through the process of importing a Microsoft Word document (.doc
and .docx are supported) to your project.
 
To import an MS Word file to your project, select the corresponding import option in the Select
import type list, locate the necessary file on your computer and click the Next button as shown in
the screenshot below:
 

 
After you click the Next button, Dr.Explain will display an HTML file conversion window:
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This means that Dr.Explain will first try to convert your original Microsoft Word (MS Word must be
installed on your computer) document (either in .doc or .docx format) into an HTML document. If
the conversion process is successful, then Dr.Explain will display the Document Styles Matching
Dialog. If you have problems during this step, cancel import, open the document in Microsoft Word,
save it as RTF and import the RTF file.
 
Then, configure document matching styles and click the OK button to continue.
 
Dr.Explain will start processing the converted HTML file. It will show the progress and display the
results in a separate window:
 

 
Click the OK button to close this window and start working on imported data in Dr.Explain.
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Saving & Closing Project
 

When working on your project, it is advised to save your project from time to time.
 
There are four ways to do so in Dr.Explain:
 

•  go to the File menu and click the Save menu option;

• 
 
click the  button;

•  use the Ctrl+S keyboard shortcut;
•  when exiting or closing your project, you will be prompted to save your project:

 

 
 
When you save your project for the first time, Dr.Explain displays the standard Save as... dialog.
You need to specify the name for your project. Dr.Explain saves projects as the files with the .gui
extension.
 
Once the project is completed, you may export it to HTML, RTF, PDF or CHM help files.

To close project, click the standard "x" button in the top right corner of the dialog or use File ->
Close.
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Handling Multiple Projects
 

Dr.Explain allows you to work on several projects at the same time. You can open your projects
either in the same instance of Dr.Explain or open each project in a separate instance of Dr.Explain.
 
You can switch between your projects using the Ctrl+TAB keyboard shortcut (if you opened
projects in one instance of Dr.Explain) or use the Alt+TAB keyboard shortcut (if you opened
several instances of Dr.Explain).
 
If you opened several projects in one instance of Dr.Explain, you can either tile the windows with
opened projects or cascade them by using the corresponding menu option in the Window menu.
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Editing Content
 

In this chapter, you will learn how to edit content in your projects:
 

•  how to manage topics and TOC;
•  how to edit text and document styles;
•  how to work with tables;
•  how to insert hyperlinks and special objects;
•  how to check spelling and preview HTML and CHM files.
 

 
Related topics:
 

Working with Images & Screenshots
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Working with Topic Tree
 

Topic Tree represents a list of the parts (topics) of a document or help organized in the tree-order
in which those parts appear.
 

 
A topic is like a single document, on which your work at a time. Dr.Explain manages Topic Tree
and topics it consists of, as a single document (project file).
 
There are two special predefined topics in Topic Tree:
•  Title page
•  Table of Contents page
 
You can expand and collapse topics in Topic Tree by using the standard controls or you can move
topics around in the Topic Tree and change the levels of your topics in the tree hierarchy.
 
The iconic buttons near the topics depend upon the project type.
For local projects there are Lock/Unlock icons:

Use these buttons to lock or unlock topics for editing. Locking topics allows to protect completed
topic from occasional changes.
 
For shared projects, Edit/Commit icons are shown.
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Use these buttons to lock topics on the server for editing and then to commit changes to the server
and to release the locked topics for other users.
 
To enable automatic numbering for topics please setup the numbering style in Project Settings /
Common Settings and then enable numbering for certain topics in Topic Properties
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Title page
 
Title page is a special predefined topic which comes first in the Project Tree and has the following

icon . In HTML output this page has a preset name "index" thus serving like index page for the
web folder on your web site.
 
Its content is preset and consist of logo, document title and subtitle. It looks like this:
 

 
You can customize each of preset elements or replace it with your own content completely. Also,
in the Title page properties you can specify if headers and footers must be shown on it and how to
start document page numbering.
 

Here you can also specify the output formats for Title page (Export to field). If you want to remove
this page from output, you should uncheck all formats in the Export to field.
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Table of Contents page
 
Table of Contents (TOC) page is a special predefined topic which comes second in the Project

Tree and has the following icon . By default this page is excluded from HTML and CHM formats
as it's mostly intended for printed formats: PDF and RTF.
 
Its content is preset and includes a special TOC object:

In the Text Editor and in Preview modes the actual page numbers are replaced with NN token.
Upon export into PDF and RTF formats NN token will be replaced with actual page numbers and
all TOC elements will work like hyperlinks. You can include \ exclude certain topics from TOC list
by pressing and buttons on the left of topic titles. Note, if the topic is excluded from TOC, this
topic will still be included into the output.
 
You can customize style of TOC object in Table of Contents Properties dialog. Simply double click
the TOC object or invoke the dialog from popup menu.
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Table of Contents Properties
 
 

Use this dialog to customize visual style for each level of Table of Contents object. To invoke this
dialog simply double click the TOC object in Table of Contents page.
 

Levels to be included

Use this drop-down to specify the
maximal number of topic levels to be included in TOC.
 

Level selector

Use the numbered buttons to select a level of TOC you want to
customize.

Press  button to add a new level of TOC to customize its style.
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Indent

Use this slider to set relative indent for each TOC
level in pixels.
 

Font settings

Specify font face, size, style and
color here.
 

Filler

Select space filling style here.
 

Delete level

Press this button to delete style settings for a selected level of TOC.
 

Excluded topics

This is an informational area that lists topics excluded from TOC.
 

Update

Press this button to accept changes and to close the dialog.
 

Cancel

Press this button to discard changes and to close the dialog.
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Adding Topics
 

Creating or adding topics is the most frequent operation you use when working with the table of
contents. It is similar to creating new documents in regular word processors. After you create a
topic, you can start adding text and other content to it or you can move it around your Topic Tree.
 
To add a topic, point your cursor at the higher level topic if you plan to add it on the same level. If
you point the cursor at a topic and choose to add a new topic, it will be added as a subtopic to the
current topic.
 
There are several ways to add a topic to Topic Tree:

• 
 
click the  button;

•  go to the Options menu and click the Add topic menu option;
•  use the Ctrl+T keyboard shortcut;
•  right-click the required topic and select Add... then Add Topic;
•  import data from other files via the Import Dialog.

 
 
There are three scenarios for adding a new topic:
 

•  topic with text;
•  topic with annotated screenshot;
•  topic with image from file.

 
When you add a topic, you will be prompted to specify its name in the Topic Tree itself. You can
always change its name later on by clicking its name and holding it for a while. After you have
changed its name, either press the Enter button or just click another topic.
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Managing Topics
 

When adding topics to your project, you need to organize the topics so that Topic Tree visualizes
the structure of your future documentation.
 
There are several ways to move topics around in the Topic Tree:
 

•  right-click the topic you want to move and select the necessary menu option: Move up or
Move down
•  use the Ctrl+Up and Ctrl+Down keyboard shortcuts
•  drag and drop topics in the Topic Tree
•  use standard OS commands: Copy, Cut and Paste

 
Keep in mind that you can copy topics even from one project to another.
 
To enable automatic numbering for topics please setup the numbering style in Project Settings /
Common Settings and then enable numbering for certain topics in Topic Properties
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Lock & Status Options
 

Locking topics in local projects
 
By locking topics in the Topic Tree of a local project, you can close a completed topic for editing
so that a topic is available only for viewing. This might be very useful when several colleagues are
working on a single project file and you can lock your topics, so that you or your colleagues cannot
change them by accident. To edit a locked topic you need to unlock it first.
 
To lock a topic, right-click it in the Topic Tree and select the Lock this item menu option. By using
this menu option you can also lock a topic and its subitems.
 
To unlock a topic, right-click the necessary topic and select the Unlock this and all subitems
menu option.
 
Another way to lock/unlock items is using the  buttons.
 
 
Locking topics in shared projects
 
For shared projects, Edit/Commit icons are shown instead of Lock/Unlock icons.

Use these buttons to lock topics on the server for editing and then to commit changes to the server
and to release the locked topics for other users. Please, read Teamwork & Collaboration section to
get more details on working with shared projects.
 
 
Status options
 
Statuses allow you to mark topics in a project tree view depending on their completeness level: 

Not started

In progress

Completed

Waiting

 
 
The colored markup helps you visualize which parts of your project are done. Using statuses is
convenient when working with large projects.
 
You may change the topic status either in its properties pane

or right-click the topic in the project tree view and use Set Status command in the pop-up menu.
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Topic Properties
 

In the Properties pane, you can specify topic or screenshot properties such as title, Help ID code,
filename, etc. This pane is located in the lower left corner of your Dr.Explain project. To change a
property, just click at the required field and specify the new value.

 

Auto numbering

 Use this option to enable or disable automatic
numeration for the topic. The preview shows you the number to be assigned to the topic in case
the option is turned on. You can setup topic numbering style in the Project Settings / Common
Settings.

Title Field

 This field shows the topic title that you have
specified when creating the topic. This name appears in the Topic Tree of the generated
document.
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Topic (Page) Name

 This field allows you
to specify the filename of the topic (without extension) for CHM and HTML output formats. If you
plan to generate online help, this name will be used as part of the name for online help. E.g. /help/
topic_properties.htm.

Output format

 Use these buttons to
include and exclude the topic from certain formats. You can also exclude (hide) a topic from all
formats by selecting it in the Topic Tree and pressing the Delete key.

Status

 This field shows the current status of the
topic.

Help ID

 Use this field to specify the Help ID numeric
code for the context sensitive help.

Topic Alias

 Use this field to specify the string alias for
the corresponding Help ID numeric code.
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Editing Text & Styles
 

You can edit text in Dr.Explain in the same way as in any word processor. You can either format
(font, size, color) your text manually or configure styles for your project.
 
Styles allow you to configure global text settings that will be used throughout your project. Once
you make changes in any style, Dr.Explain will automatically update text with the specified style in
all topics.
 
Dr.Explain's content editor allows editing topic's content in WYSIWYG style. This may include
bitmap images, texts, links, annotated screenshots, titles, tables and various objects that can be
added with the text editor.
 

 
Double-click any object to edit its properties. If you work with a screenshot, you can manage its control
references and numbered tags by double-clicking the screenshot image to switch to Designer mode.
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Text Editor Options
 

The Text Editor in Dr.Explain does not differ much from text editors in other word processors. It
allows you to perform common text formatting operations, insert tables, images and other objects,
etc.
 
Dr.Explain's embedded text editor supports rich text format with various font faces, including
Unicode fonts (to support national multibyte encodings such as Arabic or Chinese languages).
Dr.Explain also supports RTL (Right-to-Left) typing mode for some national languages, such as
Arabic or Hebrew.
 
If you need to find a word/phrase/symbol in Dr.Explain you can use the Find-and-Replace
functionality that is present in most word processors by using the Ctrl+F or Ctrl+H keyboard
shortcuts. You can also go to the Edit menu and select the appropriate menu option there.
 

 
If the working area gets tight the toolbar will be shortened and

some commands will be moved into secondary drop-down toolbars.
 

 

 

Text Style
Use this button to quickly apply a pre-configured text style to a part of text
in the editor.



Dr.Explain 4.10 : User Guide Text Editor Options

Copyright (c) Indigo Byte Systems, LLC 65 of 259

Text Formatting

 
 
Use these buttons to change the font face, size, style, format text as superscript or
subscript, or change text color.
 
Changing font face:

        

Changing font size:

 

Hint: Start typing the font name or size in the list to quickly select it there.

Paragraph Alignment
Use these buttons to change the paragraph alignment.
 

Insert Link
Use this button to link the selected text to an external URL address or internal project
node. See more: Insert Link dialog.
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Insert Image
Use this button to insert image from file, from clipboard, or a captured one.
 You can either insert a plain image or to create an annotated screenshot object.

Note, only one annotated screenshot object per topic is allowed.
 

Insert video
Use this button to insert a video into this topic.

Insert Special Object
Use this button to insert a special object into your topic.
 

 
 

The special objects are:
•  Text variables
•  Special variables (e.g. page number)
•  Horizontal line
•  HTML code snippet
•  Page title
•  Annotated screenshot
•  Control title
•  Control image
•  Control bullet

Insert Table
Use this button to insert a table into your topic.
 

Lists
Use the buttons to insert numbered or bulleted lists into your topic. The
drop-down list allows you to choose a desired numbering style from the

pre-configured list. Also you can customize list styles in Project Settings.
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Spell Checker
Click this button to enable/disable the spell checking and/or configure spell checking
settings.
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Using Styles
 

A style is a set of text formatting options, such as font name, size, color, paragraph alignment,
spacing, etc. that can be used throughout the document. By using styles you will not have to
edit each time text or heading to make it look the way you want it. Styles are applied globally
throughout the project, so instead of editing some text manually throughout the whole document,
you can just edit and apply the specific style.
 
To apply a pre-configured style in a topic, click the left most button in the editor toolbar and select
the appropriate style from the drop-down list:
 

 
Hint: Start typing the style name to quickly select it in the list.
 
You can also use keyboard shortcuts to apply styles in text editor.
 
The following styles are pre-configured by default:

•  Normal (body text)
•  Heading 1
•  Heading 2
•  Code (code selection)
•  Quote (quote selection)

 
For more details on styles and how to add/edit them, see section Text Formatting Styles.
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Working with Tables
 
Dr.Explain allows you to insert tables of any complexity. Working with tables in Dr.Explain does not
differ much from the options and operations found in other word processors.
 
Click the  button to insert a table into your topic or use Ctrl+Shift+T shortcut. The following
dialog appears:
 

 
To add a table, follow these steps:
 

•  specify the necessary amount of rows and columns in the corresponding spin boxes;
•  choose the necessary alignment for your table (default, left or right);
•  select whether you want to have a frame around the table (none or solid);
•  then configure the relative width;
•  click the OK button to insert the table.

 
To resize a table, you need to click the necessary table border and drag it in the necessary
direction.
 
To edit cell properties, right-click the necessary cell or select several cells and choose the Cell
properties... option from the pop-up menu:

 
The Cell properties dialog is similar to cell properties dialog in any word processor:
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The Vertical alignment menu has the following options:

•  top;
•  bottom;
•  middle.

 
By using the Table menu you can access the standard operations with cells:

•  add row above;
•  add row below;
•  add column to left;
•  add column to right;
•  delete row;
•  delete column.
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Inserting Hyperlinks
 
A hyperlink (link) is a reference either to a specific element in the same document or external
source (URL).
 
You may link any portion of text with an external URL or with another topic in your help file.
Dr.Explain automatically tracks the broken link and alerts you in case of inconsistency.
 

To insert a hyperlink, select the text that you want to link to other content and click the  button
or use Ctrl+K shortcut. The following dialog will be displayed:
 

To edit existing hyperlinks you need to click the necessary link (the same dialog is displayed) to make
necessary changes.

Link text

Use this field to specify the text that should be displayed as a link.
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URL Address

Select this option button to link the selected text to an external Internet address, e.g. http://
www.drexplain.com.

Internal link

Select this option button if you want to link the selected text to an existing topic in the project tree.

Control

Use this drop-down box to link the selected text to a specific control within a page.

Open link in new window

Select this check box if you want the link to open in a new browser window.

OK

Click this button to accept the changes and insert hyperlink.

Cancel

Click this button to close the dialog.

Remove link

Click this button to remove the link you clicked from the topic.
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Select current topic

Use this button to quickly select current topic in the project tree.

Ping URL

After you specified address in the URL field, click this button to verify that the link is valid.
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Adding video
 
You may enrich text content of your help manual with a movie clip. You may embed video which is
hosted on popular video services, such as YouTube, DailyMotion, Vimeo, or else.
 

To insert a video, put the cursor in a certain position in the editor and click the  button or use
Ctrl+Shift+V shortcut. The following dialog will be displayed:
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To edit an existing video simply double click on video box in the editor.
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Insert video from  video service via URL

This option allows to insert video in your help manual via URL. The most popular video
hosting services are supported: YouTube, Vimeo, and DailyMotion. Simply paste an URL
into the edit box and a wait until the preview image gets loaded into the Preview section
bellow.
 

Video box dimensions

Use this drop-down list to select a predefined size for your video
box or to specify custom dimensions.

Insert video via embedding code

You can also insert video by pasting a snippet of embedding code provided by video
service you use. Automatic parsing of this code isn't guaranteed in this case. Thus,
preview image may be unavailable as well. 
 

Video preview

Use the preview box to make sure if the video exists and it is the same one you want to
embed. The preview is a static image.
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Insert
Press this button to actually insert a video into active help topic.
 

Cancel
Press to close the dialog and to discard the changes.
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Check Spelling
 

Built-in spell checker helps you to keep your text free of typos and errors. The spell checker
highlights the misspellings and suggests replacements when you right-click them. Dr.Explain's
spell checker has a set of pluggable dictionaries for the most popular national languages.
Check spelling is enabled by default in Dr.Explain. To disable/enable it, or configure the check

spelling options click the  button.
 

To configure check spelling options, click the arrow button .
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Inserting Special Objects
 

In this section, you will learn how to insert special objects into your topics and namely:
•  variable;
•  special variable;
•  horizontal line;
•  HTML snippet;
•  page break and page title;
•  control title (for annotated screenshots);
•  table of contents.

 
 

To insert a special object, click the down arrow on this button . The following pop-up dialog
will be displayed:
 

 
Just select the object you want to insert.
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Inserting Variables
 

A variable is a symbolic name given to certain data or information that allows this name to be used
independently of the data it represents. Therefore, instead of using one and the same data or
value repetitively, you can use a variable instead of it. The application will automatically insert or
process the data/value it represents.
 
To insert a variable, click the  button or use Ctrl+Shift+R shortcut. Dr.Explain will display a
list of pre-configured variables:
 

 
See the section Variables Settings for more details and to know how to define new variables.
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Inserting Special Variables
 

You can insert special variables only into headers and footers for PDF output (Options -> Project
settings -> PDF export -> Setup).
 

To add a special variable to a header or footer, click the arrow button  next to the
Variable button, select the Special variable menu and choose the corresponding option there:
 

 
The following special variables are pre-configured:

•  page title;
•  page topic;
•  page status;
•  help ID;
•  alias;
•  keywords;
•  page number;
•  total pages.

 
When you insert a special variable, Dr.Explain automatically obtains the values for the variable
from the project settings and inserts them in the specified location (into header and/or footer) when
generating a PDF file.
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Inserting Horizontal Line
 

You can insert a horizontal line into your topic by clicking the arrow button  next to the
Variable button and selecting the Horizontal line menu option or use Ctrl+Shift+H shortcut.
 
Dr.Explain displays the following dialog:

Line Width

 Specify the line width here.

Width Value Measurement

 Specify the measurement for the line width here: either in % or pixels.

Line Height

Define line height here (in pixels).

Line Alignment

Here you can select the alignment.

Clear

This parameter specifies where the next line should appear in a browser after the line break
created by this element. This attribute takes into account floating objects (images, tables, etc.).
Possible values:

•  none: the next line will begin normally (default value);
•  left: the next line will begin at nearest line below any floating objects on the left-hand
margin;
•  right: The next line will begin at nearest line below any floating objects on the right-hand
margin;
•  both: The next line will begin at nearest line below any floating objects on either margin.
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Line Color

 You can change the color of the line by clicking the color
and selecting the necessary one from the pop-up menu:

Click Custom to specify a custom color.

OK button

 Click the OK button to accept the changes and insert a line.

Cancel button

 Click the Cancel button to close the current dialog.
If you plan to insert similar lines later on in your topics, you can just copy-paste them.
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Inserting HTML Code
 

You can insert an HTML snippet into your topic by clicking the arrow button  next to the
Variable button and selecting the HTML menu option or use Ctrl+Shift+S shortcut.
 
Dr.Explain displays the following dialog where you type or paste your html code:
 

 
After you have specified the necessary html code, click the OK button to insert an HTML snippet.
 
After you click OK, the following sign will appear in the Content Editor: . To edit the html
code, double-click this sign.
 
If you plan to insert similar HTML snippets later on in your topics, you can just copy-paste them.
 
To delete HTML snippet, click it and press the Delete button or right-click it and select the Remove
menu option from the pop-up menu.
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Inserting Page Break & Page Title
 

A page break is a mark that tells the document processor that the content after this mark is a part
of a new page. A page title is a name of a page/topic.
 

You can insert a page break or page title into your topic by clicking the arrow button  next to
the Variable button and selecting the corresponding menu option or use Ctrl+Shift+B shortcut.
 
Keep in mind that when you insert a page title and edit it, you will change its name in the TOC as
well.
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HTML, CHM, & PDF Preview
 

Dr.Explain has three view modes: Content Editor, HTML Preview, CHM Page Preview, and PDF
Preview.
 
Using the corresponding buttons you can easily switch between Editing and Preview modes:

 

Content Editor  is the pane where you add and edit the contents of your topic.
This mode is used by default.
 

To see how the contents of topic will be displayed in an HTML page, click .
Use vertical main splitter to resize the preview area to change its width and to see the mobile
layout version of the web help.
The web help layout is responsive and is optimized for small screens of mobile and tablet devices
as well.
 
 

To preview your topic in CHM, click .
 
 

To preview your topic in PDF, click .
 
 
When you open a preview of a topic either in HTML or CHM, you can see the Print preview by
clicking the corresponding link:
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Working with Graphics
 

Dr.Explain is exceptionally useful for authoring help files with many screenshots and technical
illustrations.
 
The built-in screenshot capturing tool analyzes the internal structure of captured windows or web
forms and automatically creates numbered annotations for all significant GUI elements: buttons,
fields, options, menus, toolbars, and so on. All you have to do is add text descriptions for them to
complete the window annotation.
 
A simple screenshot is just a plain snapshot of a window without any annotations or callouts, while
an annotated screenshot allows you to customize the appearance of the screenshots, bullets, and
labels.
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Inserting Images
 

In Dr.Explain, you can insert either a plain image or an annotated screenshot object into your
content. Note, only one annotated screenshot object per topic is allowed.
 
Both types of images can be either inserted from a file saved on your computer, or pasted from
system clipboard, or captured like a screenshot of a live application.
Inserting images from files is useful when you don't have access to the application you are
documenting. You can insert an image from the received screenshots and then add annotations
manually. Or you can always use the built-in capturing tool to make a screenshot and insert it in
your topic.
 
The following formats are supported by Dr.Explain:

•  BMP
•  JPG
•  GIF
•  PNG
 
 

• 
 
To insert an image into an existing topic, click the drop-down icon near  button in the

editor toolbar. You will see the numerous options:

With this menu to you can insert either a plain image or an annotated screenshot object . Also,
you can use Ctrl+Shift+P shortcut to insert a plain image.

 
 
•  If you want to add a new topic (window) with an annotated screenshot object, use  button in
the main toolbar. Press its drop-down icon to see its options.
 
 
 

Once you click the  button, the Add Image dialog appears that allows you to insert a plain
image either from a file or capture a new screenshot.
 
After you have inserted an image or captured a screenshot, you can edit its settings on the right
side of the Image properties window.
Note, for plain images you can convert them into annotated screenshot objects. Use Annotate
command in the image popup menu.
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After you have inserted an image, you can use standard commands like Cut/Copy/Paste if you
need to copy and/or move it. You can also drag an image and place it into table cells.
You can resize the image either in the Image properties window or by dragging its border into the
necessary direction.
 
 
To link your image to an internal object or external URL address, select the image and then click

the  button. The Insert link dialog appears. Specify link properties and click the OK button to
insert the link.
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Inserting Image from File
 

Once you click the  button the following dialog appears:
 

Use this dialog to browse for an image file or capture a new screenshot and define the image
properties.

Image source

Use this field to specify the type of the image:
annotated screenshot, control image, control bullet, or a custom image. When you add a new
image from a file, then 'Custom' will be selected by default.

Appearance
In this section, you can specify the image border
width and its margin.
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Dimensions
Use this section to manage the image size,
alignment, and proportions.
 
Use the Revert size button to reset image size to
original or discard your changes.
 

Image preview

The preview shows a pre-rendered snapshot of the image to be inserted.

Image Management buttons

 Click the From a file button if you want to add an
image from a file saved on your computer.

Click the Capture button if you want to add a screenshot.

Insert button

 Click the Insert button to add an image.

Cancel button

Click the Cancel button to discard your changes and close this dialog.
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Image Properties
 

This dialog is similar to the Add Image dialog. See the Inserting Image from File for more details.

To change the image properties, right-click the necessary image and select the Image properties
menu option from the pop-up menu or double-click the required image to display this dialog.

 
Use the right side of this dialog to manage the image properties.

Appearance

 Use this section to specify the image border width
and its margin in pixels.
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Dimensions

 In this section, you can configure the image size, its
alignment and proportions.

Revert Size button

 Use the Revert size button to reset the image size to
original or discard your changes.

Update button

Click the Update button to apply your changes.

Cancel button

 Click the Cancel button to discard your changes and close this dialog.
 
 
Note, for plain images you can convert them into annotated screenshot objects. Use Annotate
command in the image popup menu.
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Capturing Screenshots
 

 
You can either add a new topic with an annotated screenshot object or insert it into an
existing topic. Note, only one annotated screenshot object per topic is allowed.
 

• 
 
To add a new topic with an annotated screenshot, click the Add window button  in the main

toolbar or use the Ctrl+W keyboard shortcut.
Keep in mind that when you capture a new screenshot, Dr.Explain automatically adds it as a new
topic to the TOC.
 

• 
 
To insert an annotated screenshot into an existing topic, click the drop-down icon near 

button in the editor toolbar and select Capture and annotate command in the pull down menu.

 
Once you start capturing a new window, the following Capture an object dialog appears:
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The capture areas are highlighted in orange, so you can clearly see what part of the screen you
are capturing.
 
To capture the necessary menu option in an application, click the menu or menu button to expand,
and make sure it is highlighted and then capture your screen
 
The Capture an object dialog is displayed on top of all applications by default, so that you can
configure the required capturing options on-the-fly. If necessary, you can move the Capture an
object dialog.
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Capturing Scenarios
 

A scenario is a set of predefined rules that define how to process various window controls or
HTML tags.
 
There are four groups of rules, for every type of application:

•  for Win32 window controls;
•  for accessible objects;
•  for HTML tags;
•  for Java Swing controls.

 
Except Win32 controls, each group includes two sections:

•  Filters that define the processing order for controls or tags and for their child elements.
•  Naming rules that specify how to name controls depending on their properties.

 
Each scenario has pre-defined rules that define what objects must be recognized first:

•  Java Swing controls
•  HTML tags
•  Accessible objects
•  Win32 controls

 
Please see the section Capturing Scenario Settings for more details.
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Image Editing
 

Image editing is another feature of Dr.Explain that allows you to edit annotated screenshots by
making changes to the captured image, callouts, and captions.
 
There are several ways to switch to Image Editing mode:

•  right-click the necessary image and click the Edit menu option;
•  double-click the necessary image;

• 
 
click the Pencil icon that appears below the image .

 
Note, for plain images you can convert them into annotated screenshot objects. Use Annotate
command in the image popup menu.

 
 
 
When you enter the Image Editing mode, Dr.Explain displays the following window:
 

 
There are three tools in Image Editing mode:

•  Annotation Designer
•  Control Areas
•  Screen Editor

 

To exit Image Editing mode, click the  button or just click any other topic in TOC.
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Annotation Designer
 

Designer is a special tool for editing screenshot annotations. Here, you can manage the screenshot's
control references and numbered callouts. To display the designer, simply double-click the necessary
screenshot image in the content editor.

Designer Toolbar

The designer toolbar provides access to key functions for managing control numbered references
and screenshot snapshot.
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Designer workspace
You may rearrange and reposition numbered
control callouts here by simply selecting and
dragging them in WYSIWYG manner.
You can also adjust the size of control areas and
screenshot image itself.
 
Hold Shift key while dragging bullet mark to
snap bullet line to angles multiple of 15 degrees.
 

Tools Tabs

 Tabs allow you to switch between different tools in designer window: designer, control
areas management, and screenshot editing. The functionalities of all tools overlap though
each one is focused on different aspects of control reference and screenshot
management.

Control Properties
This panel provides access to properties of
the selected control. Its structure is very
close to the structure of topic settings pane.
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Control Description
The control
description editor
allows you to edit
the description of
the selected control.
The editor toolbar
provides access to
the editing functions.
You may also edit

control descriptions in the main content editor.
 
 The short description for certain annotation templates is available upon double click on control
bullet.

 

Accept & Close

 Use this button to accept changes and return to the main content editor.
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Annotation Designer Toolbar
 

Designer toolbar allows you to operate with screenshots, control bullets and to customize the
designer workspace.

 

Align
Use these buttons to align all the selected bullets in one click.
 

Distribute
By using these buttons you can distribute the selected bullets evenly.
 

Same Size
Use these buttons to set equal sizes for all the selected control areas.

Add Control
Click this button to add a new control reference manually.
 

Hide
Click this button to hide the control bullets without removing the controls from the
project.

Delete
Click this button to remove the selected control references from the project.
 

Annotation Template Options
Click this button to customize visual style of the screenshot, bullets, and labels. See
section Annotation Templates for more details.
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Replace Screenshot
Use this button to replace the screenshot image. For instance, it is useful when the
window was updated in the new version of your software.

Resize Screenshot
Use this button to resize the screenshot proportionally. You may also resize the
screenshot in the editor by dragging its corner handles.

Control Bounds
Use this button to show/hide the rectangles indicating bounds of control's area.
 

Zoom
Use these buttons to zoom in/out.
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Control Areas
 

Control Areas tool is useful for manually managing those control areas that Dr.Explain highlighted
automatically. To switch to the Control Areas tool, click the Control Areas tab in the Designer.
 

 

Zoom buttons

 Use these buttons to zoom in/out.

Add Control

 Click this button to add a new control reference manually.

Show/Hide Control

 Click this button to hide/show the control bullets without removing the controls from the
project.

Delete Control

 Click this button to remove the selected control references from the project.
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Control List

 This list  shows all controls available on the selected
screenshot. Use it for switching between controls.

Control Area

 Edit the control area by dragging the highlighted area borders.

Control Dimensions

 You can use these spin boxes to
set the control area dimensions in pixels.
 
All other features are the same as in the Designer.
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Control Settings
 

This section allows you to manage the control settings (such as title, description, number, visibility,
etc.) and edit the control description.
 

 

Title field
Use this edit field to set the title for the selected item.
 

Anchor/Page Name
Use this field to specify optional file name for topic or
screenshot page or the anchor name of the control

reference.

Number
Use this spin box to change the order number
of the control.

Text Editor Toolbar

These buttons allow you to format the description text and insert objects: images, links, tables, lists, macro
variables. They work in the same way in Text Editor.
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Description
Use
this
section
to
enter
the
element's

description
in
Rich
Text

Format. Use formatting buttons to mark up your text, insert the link or to check the
spelling.
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Screen Editor
 

The Screen Editor tool is a part of the Image Editing mode. Here, you can specify the visible part
of the screenshot (i.e. to crop the picture). This is extremely helpful when you want to crop a large
image and display only a certain part of it. Drag the sides of the red frame to specify the visible part
of the screenshot.
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You may also add text labels to the screenshot. Text labels are independent objects that you can
edit, move, and delete.

Text Label Toolbar
Use this toolbar add, show and delete text labels.
 

Label Font
Use this drop-down box to specify the font type of the
selected label.

Label Font Size
Specify the font size for the selected label.
 

Label Font Color
Specify the font color for the selected label.
 

Label Font Style
Specify the label text style here: bold, italic, or underlined.
 

Label Text Alignment
Specify label text alignment here: left, center, or right.
 

Label Frame Settings
Click this button to show/hide the Frame settings panel:
 

This panel allows you to edit the text frame:
•  set frame shape (box or rounded box);
•  set shape padding (in pixels);
•  set frame's background color;
•  set frame color.

Visible Screenshot Area
Drag the sides of the orange frame to set the visible part of the
screenshot.
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Managing Control References
 

Controls are functional elements of the captured window: buttons, edit fields, drop-down lists, check
boxes, and so on. Dr.Explain automatically recognizes controls during screenshot capturing and
creates annotated callouts for them. Generally, you can just add some text to control descriptions to
complete the help topic for a captured application dialog or a window.

You may see a list of annotated numbered controls on a window screenshot page.

There are two control states: visible (active) and invisible (inactive). Visible controls are displayed in
the screenshot picture in the form of numbered callouts and they are also listed in the main content
of the topic.
Each control is assigned to a rectangular area in the screenshot. Dr.Explain uses control areas to
create separate screenshots for controls. You can setup the control area by double clicking on the
image.

You can rearrange the controls, update their properties and setup their visual settings in two ways:
in the main Content Editor or in the Designer mode.
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Annotation Templates
 

The dialog allows you to customize the appearance of the screenshots, bullets, and labels. Click
the Annotation template options button in the Designer toolbar when working in Designer mode
to customize the appearance of the selected window. You may also go to the Options -> Project
Settings -> Screenshot Annotating menu option in the application menu to set the style for your
project. It will be applied to all newly created window screenshot pages.

 

Actions

 Click this button to either apply the project's settings to the
current screenshot or to import settings from another project.
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Annotation Style List

This section allows you to view the available annotation styles, add them to your project and edit
them.

Load Template button

 Click this button to load a template file from your computer.

Add Template button

 Click this button to add a template to your project.

Save Template button

 Click this button to save the edited template.

Edit Template button

 Click this button to edit the selected template. See the Editing template section for
more details.

Shadow Properties

The panel allows you to customize the shadows for the screenshot.
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Window Shadow
Select this check box if you want to capture screenshots with
a shadow.

Background Options

 Select the 'Set transparent background for
image' check box if you want to use a transparent background for screenshots.

OK button
Click this button to accept the changes you have made and close the dialog.
 

Cancel button
Click this button to discard the changes and close the dialog.
 

Help button

 Click this button to access applications help topics.
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Annotation Template Editor
 

Annotation is an important part of the Screenshot Editor. Almost all the screenshot snapshots you
make have annotations in them. Here, you can edit or create an annotation template that will fit the
needs of your product. You can change the form, color, text for callouts and bullet marks as well as
edit their behavior.
 
After you finalize the annotation template, all annotations will be drawn and organized just like you
have specified it in the template.
 
This window allows you to edit the settings of screenshot annotation. There are four main modes
for editing the annotation template:
 

•  Callout editing mode.
•  Bullet mark editing mode.
•  Behavior editing mode.
•  Preview mode.

 
Each of them is covered later in the corresponding subsections.
 
Below you can find a description of the common annotation template editor settings:

Template Name

 Click the template name to edit it.

Load Template button

 Click this button to load a template to your project from your computer.
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Callout Editing Mode

Click this option to edit the Callout settings. See Callout editing mode for more details.

Bullet Mark Editing Mode

Click this option to edit the Bullet mark settings. See Bullet mark editing mode for more details.

Behavior Editing Mode

Click this option to edit the Behavior settings. See Behavior editing mode for more details.

Preview Mode

Click this option to switch to the Preview mode. See Preview mode for more details.

Save Template button

 Click this button to save the changes you have made for the current template.

Undo button

 Click this button to undo the most recent action or, alternatively, press the 'Ctrl+Z'
keyboard shortcut.

Redo button

 Click this button to redo the most recent action or, alternatively, press the 'Ctrl+Y'
keyboard shortcut.
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OK button

 Click this button to save the changes to the template and close the window.

Cancel button

 Click this button to discard all changes and close the window.
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Callout Editing Mode
 

Use this dialog to configure settings for the callouts in your screenshot annotation template. You
can change the form and color of the objects, shapes and connectors used in the Callout. You
may also edit the text used for the specific callout object. Read the options that you can configure
below.
 
To display this window, go to Screenshot annotating, click the annotation template you'd like to edit
and click the Callout mode.
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Template Objects List

This field lists all available objects for the selected callout.

Object Controls
 
Use these buttons  to move the object in the list either higher or lower.
 

Click  to remove the selected object from the callout.
 

Use this button  to add shadow to the object or remove it.
 

Use this button  to make the object visible.

Region Editing Mode

Click this button to add or change the region settings. The following regions are available:
 

Connector Editing Mode

 
Click this button to add or change connector settings. The following connectors are available:
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Shape Settings

 
This section of the dialog displays the available options for editing shapes. It consists of the
following sections:

•  Filling options - allows you to configure the fill options such as fill style, its color, opacity
level, etc.
•  Border pattern - allows you to configure the border style and, if necessary, change its
filling options.
•  Dimensions - allows you to configure the shape dimensions.
•  Advanced - allows you to configure the advanced shape options.

Shape Settings button

 Click this button to access the shape settings.
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Text Settings button

 Click this button to access the Text options.
 

The following text options section will be displayed:
 

 
The text options window is split into two sub-sections:
•  Text settings - allows you to configure the various font options and effects
•  Padding - allows you to change the padding options

OK button

 Click this button to save the changes you have made and close the window.

Cancel button

 Click this button to discard the changes you have made and close the window.
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Bullet Mark Editing Mode
 

Use this dialog to configure the settings for the bullet marks that appear in your annotation
template. You can change the form and color of the objects, shapes and connectors used as the
bullet marks. You may also edit the text used for the bullet mark. Read below for the options you
might configure for bullet marks.
 
To display this window, go to Screenshot annotating, click the annotation template you'd like to edit
and click the Bullet mark mode.

 

 

Bullet Editing Mode button

Click this button to switch to Bullet mark editing mode.
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Object List

This field lists all the available objects for the selected callout.
 
The following controls are available for objects.
 

 
Use these buttons  to move the object in the list either higher or lower.
 

Click  to remove the selected object from the callout.
 
Use this button  to add shadow to the object or remove it.
 

Use this button  to make the object visible.

Region Editor

 
Click this button to add or change the region settings. The following regions are available:

 

Connector Editor

 
Click this button to add or change the connector settings. The following connectors are
available:
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Shape Settings

This section of the dialog displays the available options for editing shapes. It consists of
the following sections:
 
•  Filling options - allows you to configure the fill options like fill style, its color, opacity level,
etc.
•  Border pattern - allows you to configure the border style and, if necessary, change its
filling options.
•  Dimensions - allows you to configure the shape dimensions.
•  Advanced - allows you to configure the advanced shape options.

Shape Options button

Click this button to access the shape settings.
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Text Options button

Click this button to access the Text options.
 
The following text options are available:

 

 
The text options window is split into two sub-sections:
•  Text settings - allows you to configure the various font options and effects.
•  Padding - allows you to change the padding options.

OK button

 Click this button to save the changes you have made and close the window.

Cancel button

 Click this button to discard the changes you have made and close the window.
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Behavior Editing Mode
 

Use this dialog to configure the behavior of callouts and bullet marks in your annotation template.
You can configure how connection points should be shifted and whether control titles should be
flipped on a screenshot.
 
To display this window, go to Screenshot annotating, click the annotation template you'd like to edit
and click the Behavior mode.
 
Select an object to specify its behavior depending on its position.

 
 

Behavior Editing Mode button

Click this button to switch to Behavior editing mode.
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Shifting Options for Connection Points
In this section, you can specify how connection points should be shifted in the annotation
window. The following options are available:

 

• 

 

 - No shift of connection points

• 

 

 - Vertical shift of connection points

• 

 

 - Horizontal shift of connections points

• 

 

 - Bidirectional shift of connection points

• 

 

 - Rotational shift of connection points.

Orientation Options
This section allows you to configure the orientation of callouts on your annotation window.
The following options are available:

 

• 

 

 - No flip

• 

 

 - Flip orientation vertically

• 

 

 - Flip orientation horizontally

• 

 

 - Flip orientation bi-directionally

OK button

Click this button to save the changes you have made and close the window.
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Cancel button

Click this button to discard the changes you have made and close the window.



Dr.Explain 4.10 : User Guide Preview Mode

Copyright (c) Indigo Byte Systems, LLC 128 of 259

Preview Mode
 

Use this window to preview the changes you have made previously to callouts, bullet marks and
their behavior on the annotation template.
 
To display this window, go to Screenshot annotating, click the annotation template you'd like to edit
and click the Preview mode.
 

 

Preview button

Click this button to access the Preview mode.

Preview Window
This area shows a preview of the annotation template.

OK button

Click this button to save the changes you have made and close the window.
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Cancel button

Click this button to discard the changes you have made and close the window.
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Project Settings
 

Project settings allow you to configure the settings for the current project only.
 
There are three ways to open Project Settings dialog:

• 
 
click  on the application toolbar;

•  use Ctrl+Alt+P shortcut;
•  go to the Options menu and click the Project settings menu option.

 
 
In Project Settings you can configure the following options:

 
You can also import settings from another project file with Options -> Import settings .
 
See the corresponding section for more details on a specific topic.
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Import project settings
 

You can also import settings from another project file with Options -> Import settings. This is very
handy if you wish to apply the settings from one project to another one. You can import either all
settings or just certain ones.
 
Note: This action cannot be undone. So, please use this function carefully.
 

Path to project

Use this field to specify path to a project which settings are to be imported.
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Settings list

Use this list to specify what settings are to be imported.
 

Quick selection buttons

Use these buttons to quickly select or unselect all options in the
settings list.
 

Import button

Press the button to start importing.
 

Close button

Press this button to close the dialog and cancel importing.
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Common Settings
 

In common settings you can configure how Dr.Explain generates new names to the new topics you
create.
 

 
 

Generate a filename using relative numbering (like in previous versions)

Select this option button if you want to generate file names using relative numbering (as in
previous versions of Dr.Explain).

Generate a filename by title

Select this option button if you want to generate file names using their titles.

Automatic numeration for topics

Check this option to enable automatic numbering for the project topics. Use options bellow
to customize the numbering format and style.
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Exclude topic numbers from content

Check this option to show topic numbers in the table of contents, topic lists, and search
results only.

Topic level

Use the numbered buttons to select a topic level you want to customize.

Type of numbering

Use this drop-down to set the numbering type for a certain level of topics.

Type of delimiter

Use this drop-down to set the delimiter type for a certain level of topics.

Final delimiter

Use this option to enable or disable the delimiter sign in the end of the number for current
topic level.

Previous level  concatenation

Uncheck this option if you want to exclude all parent level numberings from current level's
number.

Preview

The preview area displays numbering style of all levels at once. Currently selected level is
colored with black. Also, you can click a level you want to customize.

OK button

Click this button to accept your changes and close the window.
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Cancel button

Click this button to discard all the changes and close the window.

Help button

 Click the button to open the help window.

Actions

Use this button to import settings from another project or to reset file names of all topics to
automatically generated values.



Dr.Explain 4.10 : User Guide Screen Capturing Settings

Copyright (c) Indigo Byte Systems, LLC 136 of 259

Screen Capturing Settings
 

In the Screen Capturing settings you can configure the capturing process. To customize the
capturing settings of the current project either:

•  go to the Options menu and select the Project Settings menu option;

• 
 
or click the  button in the application toolbar.

See also: Capturing Screenshots section.
 

Always on top

 Select this check box to display the Capture Window dialog on top of all
applications.

Hidden

Select this check box to hide the Capture Window dialog in the system tray.

Draw no bounds

 Select this check box if you don't want the colored rectangle around the
captured window to be shown when you point your cursor at it.
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Hide "Capture window" dialog while capturing window

 Select this check box if you don't want
the Capture window dialog to be displayed when capturing snapshots.

Use virtual pointer

If this check box is selected, then you can press and hold the right
Ctrl button to lock the cursor in certain position (e.g. over a certain button to activate its
pop-up tooltip). Then, you can continue selecting windows/controls to be captured with
another "virtual" cursor.

Bullets placement

 Select appropriate option button to specify how to distribute the
numbered callouts around the captured windows.

Control area padding

 Use this spin box to specify here how many extra
pixels should be added around the actual control area.

Capturing scenarios

Use this section to create, edit and setup various capturing scenarios.

Boundary  colors

 Click the colored boxes to specify
the frame color to be used for highlighting the screen areas when pointing the cursor at
them.

OK button

 Click this button to accept the changes and close the dialog.

Cancel button

 Click this button to discard your changes and close the dialog.



Dr.Explain 4.10 : User Guide Screen Capturing Settings

Copyright (c) Indigo Byte Systems, LLC 138 of 259

Help button

 Click this button to access the context help.
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Scenario Settings
 

Capturing scenario is a set of predefined rules that define how to process various window controls
or HTML tags.
 
There are four groups of rules, for every type of application:

•  Win32 window controls.
•  Accessible objects.
•  HTML elements.
•  Java Swing control.

 
Except Win32 controls, each group includes two sections:

•  Filters define the processing order for the controls or tags and for their sub-elements.
•  Naming rules specify how to name controls depending on their properties.

 
The main page of the Scenario Properties is accessible through Screen Capturing Settings. It
allows you to set the main properties of the capturing scenario.
 
 

 

Scenario name

 
 
Specify the scenario name here.
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Scenario description

 
 
 

 
Use this optional field to specify the scenario's custom description.

Capture Swing (Java)

 
Select this check box if you want to capture Java Swing controls.

Capture HTML

 
Select this check box if you want to capture HTML elements.

Capture Accessible objects

 
Select this check box if you want to capture accessible objects in various applications.

Capture Win32 windows

 
Select this check box if you want to capture Win32 window controls.

Export scenario

 
Click this button if you want to export your scenario as a file. After you export your
scenario, you can share it with another member of your project team or keep it for backup
purposes.

OK button

 
Click this button to save your changes and close the dialog.

Cancel button

 
Click this button to discard your changes and close the dialog.

Help button

 
Click this button to display help.
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Scenario Properties: Filters
 

The Filters define the processing order for controls or tags and their child elements depending on
their name and properties.
 
The settings for filters for accessible objects, HTML elements and Java (Swing) are almost the
same. Let's look at the options available for accessible objects filters, as they have more options:
 

 

Roles language

 
Use this drop-down box to specify whether the object role should be interpreted as

•  English strings.
•  Localized system values.
•  "ROLE_SYSTEM_xxx" values.

This option is used for Accessible objects only.

Filter list
The list displays the set of filters specified.
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Move Up & Down

 
Use these buttons to change the priority of the selected filter.

Filter managing buttons

 
Use these buttons to create, edit or delete filters.

OK
Click this button to accept your changes and close the dialog.

Cancel
Click this button to discard your changes and close the dialog.

Help
Click this button to display help.
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Editing Accessible Objects Filters
 

Use this dialog to setup a control processing filter for accessible object, window, or Java (Swing)
control.
 

 

Filter by name

 Use this section to set a logical
condition based on a control name comparison.

Filter by role

 Use this section to set a logical
condition based on an object role comparison.

Filter by state

 Use this section to set a logical
condition based on an object state.

Highlighting

Select this check box if you want to highlight the
control when the cursor is over it.



Dr.Explain 4.10 : User Guide Editing Accessible Objects Filters

Copyright (c) Indigo Byte Systems, LLC 144 of 259

Parse child objects

Select this check box if you want to parse child objects as well.

Name is case sensitive

 Clear this check box to ignore case in name string comparison.

Roles language

Select these check boxes to specify if an object role should be
interpreted as a localized string (English by default).

States

 Specify the states that you want to filter the objects by selecting the
check boxes next to them.

Object parsing

Select this check box if you want to include this object in the project and select a type of inclusion:
•  Add as visible control.
•  Add as invisible control.
•  Add as a separate screenshot page (sub-window).

OK

 Click this button to accept your changes and close the dialog.

Cancel

Click this button to discard your changes and close the dialog.

Final settings

The icons display the filter action in a compact iconic style.
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Editing HTML Elements Filters
 

In this dialog, you can configure the control processing filters for HTML tags.
 

 
 

Filter by tag name

 Use this section to set logical a
condition based on an HTML tag name comparison.

Filter by class name

Use this section to set a logical
condition based on an HTML tag class attribute comparison.

Filter by tag type

 Use this section to set a logical
condition based on an HTML tag type attribute comparison.

Highlighting

 Select this check box to highlight the HTML
element when the cursor is pointing at it.

Parse child tags
 Select this check box to parse inner HTML tags as well.



Dr.Explain 4.10 : User Guide Editing HTML Elements Filters

Copyright (c) Indigo Byte Systems, LLC 146 of 259

Scrolling
Select this check box to automatically scroll

the HTML element area to capture it as a whole element.

Case sensitive comparison

 Clear these check boxes to ignore the case in a filter string comparison.

HTML element parsing

Select this check box to include this HTML element into the project and select a type of inclusion:
•  Add as visible control
•  Add as invisible control
•  Add as a separate screenshot page (sub-window).

Final settings

 These icons display the filter action in compact iconic
style.

OK

 Click this button to accept your changes and close the dialog.

Cancel

 Click this button to discard the changes and close the dialog.
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Scenario Properties: Naming Rules
 

The Naming rules specify how to name the controls depending on their properties.
 

 

Roles language

 
 

Use this drop-down box to specify if the object role should be interpreted as an English
string or as a localized one.
This option is used for Accessible objects only.
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Rule list

 
 
This list displays the set of naming rules specified.

Up & Down

 
 
Use these buttons to change the priority of the selected naming rule.

Naming rule managing buttons

 
 
Use these buttons to create, edit or delete naming rules.

OK
Click this button to accept your changes.

Cancel
Click this button to discard your changes and close the dialog.

Help
Click this button to display the context help.
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Editing Accessible Objects Naming Rule
 

Use this dialog to set up a control naming rule for an Accessible object or a Java Swing control.
 

 

Filter by name

 Use this section to set a logical
condition based on a control name comparison.

Filter by role

 Use this section to set a logical
condition based on an object role comparison.

Filter by state

 Use this section
to set a logical condition based on an object state.

Case sensitive comparison

 Clear this check box to ignore the case in a name string comparison.

Role language

Select this check box if you want to specify whether an object role
should be interpreted as a localized one (English by default).
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Naming pattern

 Use this field to specify the
naming pattern using predefined macros.

Predefine control description

 Click this button to
open the text editor for specifying the control description pattern:
 

Save

 Click this button to save your changes and close the dialog.

Cancel

 Click this button to discard the changes and close the dialog.
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Editing HTML Element Naming Rule
 

In this section, you can set up a control naming rule for HTML tag.
 

 

Filter by tag name

 Use this section to set a logical
condition based on an HTML tag name comparison.

Filter by class name

 Use this section to set a logical
condition based on an HTML tag class attribute comparison.

Filter by tag type

 Use this section to set a logical
condition based on an HTML tag type attribute comparison.
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Naming pattern

 Use this section to specify the
naming pattern using predefined macros.

Predefine description

 Click this button to open the text
editor for specifying the HTML element description pattern:

 

Save

 Click this button to save your changes and close the dialog.

Cancel

Click this button to discard the changes and close the dialog.
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Editing Win32 Control Naming Rule
 

Use this dialog to setup a control naming rule for Win32 window control.
 

 

Filter by name

 Use this section to set a logical condition
based on a control name comparison.

Filter by caption

 Use this section to set a logical condition
based on a caption comparison.

Filter by window style

 Use this section to set
a logical condition based on Win32 control's window style.

Filter by extended window style

 Use this section to set
a logical condition based on Win32 control's extended window style.
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Naming pattern

 Use this field to
specify the naming pattern using predefined macros.

Predefine control description

 Click this button to
open the text editor for specifying the control description pattern:
 

Case sensitive comparison

 Clear these check boxes to ignore the case in a name string comparison.

Save

 Click this button to accept your changes and close the dialog.

Cancel

Click this button to discard the changes and close the dialog.
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Export Settings
 

Dr.Explain's file format is .GUI. Therefore, the final step in creating end-user documentation is to
export your project to the required file format.
 
Dr.Explain allows you to generate a set of HTML files that you can plug into your website or a
single CHM file that you can ship with your software. It is also capable of exporting your project
into RTF or PDF documents.
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HTML Export Settings
 

In this dialog you can configure the appearance for the generated HTML pages. To access the HTML
Export settings you can either:

•  go to the Options menu and select the Project settings menu option

• 
 
click the  button in the application toolbar.

See also: Publishing HTML Help , Publishing CHM File , CHM Export Settings.

 



Dr.Explain 4.10 : User Guide HTML Export Settings

Copyright (c) Indigo Byte Systems, LLC 157 of 259

File extension

 
Use this drop-down list to specify the extension for the output files:
 
•  asp;
•  aspx;
•  htm;
•  html;
•  shtml;
•  phtml;
•  phtm;
•  php;
•  pl;
•  py.

... or use your own extension.

Image subfolder

Specify in this field the subfolder where the image files are located.
Example: if your HTML files will be placed in /help/ folder and you want to keep all image files in /
help/img folder then specify img in this field.

Color theme

 
Select this option button and choose a predefined color theme for the output HTML files.
You may also create your own color themes by using the buttons next to the theme list.

Additional CSS
Select this option button to specify you own CSS code to override CSS generated by
Dr.Explain. You can customize the appearance of HTML pages: fonts, colors, sizes, etc. After

you choose an existing color theme, Dr.Explain opens built-in CSS editor:
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HTML Template & Layout

Click this button to customize page's header, footer, and navigation elements to insert your
logo, global website menu, scripts, copyright notices, corporate graphics and so on.

Pop-up tooltips

Select this check box to enable pop-up tooltips that will be displayed when the cursor points
at the bullet on the screenshot picture. The tooltips may include the associated control
description, so that the user doesn't have to scroll down the page to read it.

Actions button
Click this button to import settings from another project file or from  CHM HTML
export settings.

OK button
Click this button to save your changes and close the dialog.

Cancel button
Click this button to discard the changes and close the dialog.

Help button

 Click this button to display help.
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Editing Theme Colors
 

In this dialog you can change the settings of the selected color theme used for HTML export.

To edit the theme colors, click the  button. The following dialog appears:
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Preview

Use this area to instantly preview the overall design and style of elements. The preview is
made on Internet Explorer web browser.
Resize the window to change the width of the preview area to see the mobile layout
version of the web help.

Colors

Click the color boxes to change the color of visual elements.

Open in browser

Click this button to preview your custom design in your default web browser.
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OK button

 Click this button to save your changes and close the dialog.

Cancel button

 Click this button to discard the changes and close the dialog.
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HTML Template &  Layout
 

This dialog allows you to configure the structure of your HTML online manual or CHM file. You can
customize the page's header, footer and navigation; insert your logo, global website menu, scripts,
copyright notices, corporate graphics and so on.

The left side of the dialog represents the page layout with clickable sections. Click a section to
customize its content or properties. The selected section is highlighted with bright orange color.
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Advanced view

 If you are experienced in HTML code and you want to see the structure
of the HTML tags in your pages, then select this check box. Besides HTML tags, you can
customize not only the visible parts of the HTML pages but several extra sections as well:
Pre-HTML, Pre-Body, Post-Body, Post-HTML. This is useful when you need to embed
scripts, headers, or other advanced content into the HTML code of the pages.

RTL support

Check the option to enable Right-To-Left support for your project.
 

Page layout
The left side of the dialog represents the page layout with clickable
sections. Click a section to customize its content or properties. The
selected section is highlighted with bright orange color.
 

Viewable header & footer

 If you select this check box it means that the height of the online
manual will be automatically adjusted to fit to the height of the browser window. The
header, footer and sidebars will be docked to the browser edges while the central content
part will remain scrollable. This resembles the behavior of a CHM file.

Code standard

Use this drop-down list to specify the code
standard for the HTML output:
•  HTML5
•  XHTML 1.0 Strict

Help content settings
This section is available
when customizing the
main (central) content

section of HTML page. Use it to set the dimensions of the help content.
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Navigation bar settings
This section is
available when
customizing the main
(central) content
section of the
HTML/CHM page.
 
In this section, you can

configure the structure and dimension of the left navigation sidebar. Turn on/off the menu,
the keyword index tab and activate the full text search function.
 

Navigation settings
This section is
available when
customizing the main
(central) content
section of the
HTML/CHM page.

 
Use these options to specify which navigation elements must be inserted into the content
of your topics.

Import from file

 Click this button to import the settings from an external file.

Export to file

Click this button to save all the settings to an external file.

OK

 Click this button to save your changes and close the dialog.

Cancel

 Click this button to discard the changes and close the dialog.
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Sitemap Options
 

In this dialog, you can create a Google sitemap file for your HTML help pages.
 
To customize the sitemap creating settings for the current project either:

•  go the Options menu and select the Project settings menu option;

• 
 
or click the  button in the application toolbar.

 
Dr.Explain displays the following dialog:

Base URL

Enter the base URL for your sitemap here.

Sitemap protocol

 Use these option buttons to choose which sitemap
protocol/format should be used for your sitemap file.
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Extra tags

 Specify here as to which extra tags must be added to the sitemap XML
file by selecting the corresponding check boxes next to them.

Compression

 Select this check box to compress your output
XML file with a GZIP compression algorithm.

Sitemap file creation during HTML export

Here, you may specify whether the sitemap file must be created each time you export your
project in HTML format. Here you can also specify the name of the folder for the sitemap
file.

Additional sitemap list

If you have several sitemaps for different parts of your website then use this list to add
them. Dr.Explain will generate the sitemap index file with links to all the sitemaps specified
in the list.

Make sitemap button

 Click this button to generate a sitemap file.

Make index button

 Click this button to generate a sitemap index file.

Add / Remove sitemap button

 Use these buttons to add external sitemap files to the index table and/or
to remove the existing entities.

Import button

 Use this button to import settings from another project file.
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OK button

 Click this button to accept changes and close the dialog.

Cancel button

 Click this button to discard changes and close the dialog.

Help button

 Click this button to show context help.
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Comments and social networks
 
In this dialog, you can enable user comments and social networks sharing for your online help
manual. This will allow users to add their own content to your online documentation and to share
links to your help pages with other people via social networks and social services.
 
To customize the comments and sharing settings for the current project either:

•  go the Options menu and select the Project settings menu option;

• 
 
or click the  button in the application toolbar.

 
Dr.Explain displays the following dialog:

 

Import settings

Use this button to import settings from another project file.
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Online help base URL

Please specify here full base URL of online manual folder on your website. This URL will
be used for composing of pages URLs. Wrong URL may cause problems with sharing and
commenting functionality.
 

Enable Facebook comments

Check this option to enable Facebook comments in your online help.

Facebook comments box width

Use this field to specify width of the box with Facebook comments.

Number of initial Facebook comments

Set here the number of Facebook comments to show initially when page is loaded. Users
can expand hidden comments themselves later.   

Color of Facebook comments box

Use this field to specify color scheme of the box with Facebook comments. Usually it may
be Dark or Light.

Facebook ID type for moderation purposes

If you wish to moderate comments and receive notification about new comments in your
Facebook account then you must provide either your Facebook User ID or Facebook
Application ID.

Facebook ID for moderation purposes

Enter your Facebook ID here. The value depends on ID type you've set in the previous
field.

Enable Disqus comments

Check this option to enable Disqus comments in your online help.

https://developers.facebook.com/apps
https://developers.facebook.com/apps
http://disqus.com/for-websites/
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Disqus ID

Provide your website Disqus code here. If you haven't one then you may receive it for free
at http://disqus.com/for-websites/

Position of social networks sharing panel

Specify if the panel with social networks sharing buttons must be shown bellow or above
the main content.

Social networks

Select social networks you wish to integrate with your online help manual. The buttons of
selected services will be shown on sharing panel in your online help manual.

URL of custom image for sharing

Specify URL of a custom image to display on social networks when someone shares your
content. If the URL is empty then an image will be chosen automatically. Usually it's the
most important image on the shared page.
 

OK button
Click this button to accept changes and close the dialog.

Cancel button
Click this button to discard changes and close the dialog.
 

Help button
Click this button to show context help.

http://disqus.com/for-websites/
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HTML files uploading
In this dialog, you can enable automatic uploading of output HTML files onto a web server via FTP
or onto your Tiwri site. With this function your online manual gets immediately available for your
customers once the export completed.
 
To customize the uploading settings for the current project either:

•  go the Options menu and select the Project settings menu option;

• 
 
or click the  button in the application toolbar.

 
Dr.Explain displays the following dialog:

Import settings

Use this button to import settings from another project file.
 

Publish files via FTP

Check this option to automatically upload output files onto a web server via FTP.
 

http://tiwri.com/?ref=help_upload
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FTP server

Use this field to set your FTP server host name or IP address.
 

FTP port

Use this field to set your FTP server port number. Default FTP port is 21.

FTP folder

Use this field to set relative path to specific folder on your FTP server.

FTP credentials

Use this button to provide your FTP credentials: FTP user name and
password. If the credentials are not provided then you'll be asked for username and
password each time HTML export and publishing is performed.
 

Publish on tiwri.com

Use this checkbox to enable automatic publishing on your Tiwri site. Tiwri site is a site on
The Technical Writing Platform Tiwri.com which is setup specially for publishing online
manuals from Dr.Explain.
 
To publish your documentation online on tiwri.com, you don’t need to deal with web
hosting settings, write webpage code, or configure FTP access.
Your online documentation will have the unique address <something>.tiwri.com. If you
want the documentation to be part of your website, you can use your domain name (for
example, help.<your_domain>) instead.

Tiwri site credentials

Use these fields to specify name of your Tiwri site (it usually looks like
<yoursitename>.tiwri.com) and password for publishing that you can change in your Tiwri
account.

http://tiwri.com/?ref=help_upload
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Browse Tiwri site files

Click this button to view files and folders in your Tiwri site.

Open Tiwri site in web browser

Click this button to open your Tiwri site in default web browser.

Create Tiwri site

Click this button to open your Tiwri account in web browser or to create a new one if
required.

OK button

Click this button to accept changes and close the dialog.
 

Cancel button

Click this button to discard changes and close the dialog.
 

Help button

Click this button to show context help.
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PDF Export Settings
 

In this dialog, you can configure the appearance of the output PDF file.

To customize the PDF settings for the current project you can either:
•  go to the Options menu and select the Project settings menu option;

• 
 
or click the  button in the application toolbar.

See also: Publishing PDF File.

Dr.Explain displays the following dialog:

PDF Document Metadata
Use these fields to enter the PDF file metadata, such as
Title, Subject, Author, and Keywords. This data will be
shown in the PDF file properties. It won't affect the
document layout or visible content.
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Page Dimensions

 Use
this section to specify dimensions for PDF pages. You may either select a predefined
standard dimension from the predefined list or specify your own custom dimensions.

Topic bookmarks

Create a bookmark tree consisting of all topics PDF file.

Keep control description within page

 Select this check box if you want to keep a control
description within a page in the PDF file. If a control description is too large to fit entirely
on the page where previous control's description is already present, it will start from the
new page.

Topics vs Pages

Use this option to specify if each topic must be started on a new page. If you uncheck this
option, you can insert page breaks manually in the text editor for topics you want to start
from the new page.

Headers & footers settings

 Click this button to customize the headers and
footers of PDF page and page numbering style.

Import button
Click this button to import settings from another project.
 

OK button

Click this button to save your changes and close the dialog.

Cancel button

 Click this button to discard the changes and close the dialog.

Help button

 Click this button to show the context help.
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PDF Headers and Footers
 

In this dialog you can configure the appearance of the headers and footers in the generated PDF file:

 

Distinct layout for odd and even pages

 Select this check box if you want to configure a different
layout for odd and even pages.
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Show header and footer on the first page

 Select this check box if you want to show the header and
footer on the first page of the generated PDF file.

Header string

Use this section to customize the header for the generated PDF file.

Footer string

Use this section to customize footer for the generated PDF file.

Page margins

Use this section to configure the page margins for the PDF file.

Header and footer height

Use this section to set the header and footer height and margins for the PDF file.
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Units

Use this spin box to set measurement units for values shown in this dialog:
•  inches;
•  mm;
•  pt.

OK button

 Click this button to save your changes and close the dialog.

Cancel button

 Click this button to discard the changes and close the dialog.
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CHM Export Settings
 

In CHM Export settings you can configure the options for the CHM file that you want to generate
from your project. CHM Export settings do not differ much from those in HTML Export Settings.

There are several ways to configure the CHM export options for your project:

• 
 
click the  button to display the project settings and then click CHM export in the

appeared dialog;
•  go to the Options menu and select Project settings menu option.

The CHM Export settings dialog looks like this:

Language

 Use
this drop-down list to set the language for the CHM output file.

Default topic

 In this field you can set the default topic that
will be displayed when the user opens the CHM file. Click the Browse button to select the topic
from the existing TOC.
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Work folder

 Use this field to specify the folder that
Dr.Explain must use as a temporary location for intermediate HTML and picture files.

Image subfolder

 Use this field to specify the subfolder for
image files.

Example: If your HTML files will be placed in /help/ folder and you want to keep all image files in /
help/img folder then specify img in this field.

Keep temporary files

Select this check box if you want to keep temporary files in work folder after CHM
compilation.

Color theme
Select this option
button and choose

a pre-defined visual theme from this drop-down list that you want to apply for the output CHM file.

To create your own theme colors, click the  button next to the selected color theme.

Custom CSS

 Select this option button if you want to apply a custom CSS file by
editing its appearance based on the selected existing color theme and changing fonts, colors, sizes,
etc.

Setup HTML Template & Layout

 Click the Setup button to customize page's header,
footer and navigation elements and to insert your logo, global website menu, scripts,
copyright notices, corporate graphics and so on.

Pop-up tooltips

 Select this check box if you want Dr.Explain
to show pop-up tooltips for clickable areas when the user points the cursor at a bullet on the
screenshots picture. The tooltips may include the associated control description, so that the user
does not have to scroll down the page to read it.
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CHM window settings

Use this section to configure settings for CHM windows:
•  select the Topmost window check box to make the CHM file display on top of all windows;
•  click the Customize button to edit the default size and position for the generated CHM file:

Actions
Click this button to import settings from another project file or from HTML
export settings.

OK button
Click this button to save your changes and close the dialog.
 

Cancel button
Click this button to discard the changes and close the dialog.

Help

 Click this button to display the context help.
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Help ID Management
 

In this dialog you can configure the context sensitive help options for your CHM files.
There are several ways to configure Help ID management options for your project:

• 
 
click the  button to display the project settings and then click Help ID management in

the appeared dialog;
•  go to the Options menu and select Project settings menu option.

Help ID in CHM

 Select this check box if you want to embed Help ID support into CHM
file.
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Map file creation

Select this check box if you want to create an external map file in the same directory with
the CHM file.
 
The content of map file depends on its extension:
•  .h - C++ code will be generated;
•  .cs - C# code will be generated;
•  .vb - VB code will be generated;
•  .inc - Object Pascal code will be generated.
 
Then, add this file to your project.

Make prefix option

 Use this edit field to specify the prefix
string for auto-generated aliases.

Character case transformation

Use this drop-down list to define how Dr.Explain must handle the case of the strings used in
composed alias names.

Topic alias template

Use this drop-down list to select a template that Dr.Explain must use for auto-generating a page's
alias.

Control alias template

Use this drop-down list to select a template that Dr.Explain must use for auto-generating a control's
alias.

Hex mode

 Select this check box if you want to display and edit Help
ID values in hexadecimal mode.

Import Settings button

 Click this button to import settings from another project file.

OK button

 Click this button to save your changes and close the dialog.

Cancel button

 Click this button to discard the changes and close the dialog.
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Help button

 Click this button to display the context help.
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CHM Compiler Settings
 

In this section, you can configure additional CHM Compiler options.
 
 

Compatibility drop-down list

Use this drop-down list to select the compatibility level for the generated CHM files.
Possible values are:
•  1.0;
•  1.1 or later (default).

Support enhanced decompilation

Select this check box if you want the generated CHM file
to support enhanced decompilation.
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FTS stop list file name

The
field displays the name of the full text search stop list file name.
 

A stop list decreases the size of full-text search index, which results in a smaller compiled help
(.CHM) file because fewer words are indexed. It is important if you have large documentation
set. All words in the stop list are omitted from the search. These are usually commonly occurring
words or numbers, such as "the", "and", or "1" that the user is unlikely to search for.
 

Click this button  to browse for the full text search stop list file.

Microsoft HTML Help Workshop

 Use
this field to specify the path where the Microsoft HTML Help workshop is installed on your
computer.

OK button

Click this button to save your changes and close the window.

Cancel button

Click this button to discard the changes and close the window.

Help button

 Click the button to open the help window.
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RTF Export Settings
 

In the RTF export settings dialog you can configure the appearance of the output RTF file. There are
several ways to access the RTF export options:

• 
 
click  button to display project settings and then click RTF export in the appeared dialog;

•  go to the Options menu and select the Project settings menu option.

Dr.Explain displays the following window:

Page header

 Use this field to specify the text to be used as the
header of each page, e.g. title of the document.

Page footer

 Use this field to specify the text
to be used as the footer of each page, e.g. copyright notices.
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Scale images to fit page width

Select this check box if you want to automatically resize images during project export so that they
fit the specified width.

Default font

Use this field to set the default text font.

OK button

 Click this button to save the changes and close the dialog.

Cancel button

 Click this button to discard the changes and close the dialog.

Help button

 Click this button to show context help.

Import Settings button

 Click this button to import settings from another project file.
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Text Strings
 

Use this dialog to customize the predefined text strings that will be inserted into the output documents.
There are several ways to access the Text strings options:

• 
 
click the  button to display the project settings and then click Text strings in the

appeared dialog;
•  go to the Options menu and select the Project settings menu option.
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Text string table
To edit a text string, click
the text cell where you want
to set your custom text for
the string resource.
 

Actions button
Click this button to import settings from another project file or to reset
settings to default values.

OK button
Click this button to save your changes and close the dialog.
 

Cancel button
Click this button to discard all changes and close the dialog.
 

Help button

 Click this button to display the context help.
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Designer Area Settings
 

You can use this dialog to customize the designer area to your liking. You can open the designer

area options by clicking the  button when in the Designer mode.
 
Dr.Explain displays the following dialog:

 

Grid step

 Use this numeric field to specify the distance
between lines of the designer area grid in pixels.

Grid line color

 Click the color box to set the color for the
designer area grid.

Control rectangle color

 Click the color box to specify the color for control
rectangles that are drawn with dashed line style.

OK button

 Click this button to save your changes and close the dialog.
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Cancel button

 Click this button to discard the changes and close the dialog.

Help button

 Click this button to show the context help.
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Content Editor Settings
 
In this dialog you can configure the text editor settings, such as spell checking. To do so, you can:
 

•  go to the Options menu and select the Project Settings menu option;

• 
 
click  to display project settings and then click Content Editor in the appeared

dialog.
 
 

Suggest from main dictionaries only

Select this check box if you want the application to suggest words only from the main
dictionaries.
 

Ignore words in UPPERCASE

Select this check box if you want the application to skip words in UPPERCASE.
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Ignore words with numbers

Select this check box if you want the application to ignore words containing numbers.
 

Ignore Internet and file addresses

Select this check box if you want the application to skip checking Internet and files
addresses.
 

Custom dictionary path

Here you can specify the path to the custom dictionary. Click the  button to browse a
custom dictionary file (.dicu format).
 

Main dictionary list

Select the check boxes next to the languages for the
dictionaries the application must use for spell checking.
 

Import settings

 Click this button to import the settings from another project file.
 

OK button

 Click this button to save your changes and close the dialog.
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Cancel button

Click this button to cancel your changes and close the dialog.
 

Help button

Click this button to show the context help.
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Variables
 

In this dialog you can configure the text variables for your project. To edit the variables, you can:
 

•  go to the Options menu and select the Project Settings menu option;

• 
 
click  to display project settings and then click Variables in the appeared dialog.

 
 
You can use variables in text descriptions by clicking the Insert Variable button in the text editor
toolbar.
 

Example: You can add variable VERSION and set its value to "1.5" and then use it
throughout the project. To change the version number to "2.0" you only need to change the
value of the variable instead of all the descriptions where it is mentioned.
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List of text variables
The list displays the text
variables that are defined
for the project. You may
use these variables in text
descriptions by clicking the
Insert Variable button in
the text editor toolbar.

Add/remove variable buttons

Use these buttons to add new variables to the list or remove them.

OK button
Click this button to save your changes and close the dialog.
 

Cancel button
Click this button to cancel your changes and close the dialog.
 

Help button
Click this button to show the context help.
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Text Formatting Styles
 

In this dialog you can configure the text formatting styles. You can use these styles to quickly format
the text in the Content editor. To edit the formatting styles:

• 
 
click the  button to display the project settings and then click Formatting styles in the

appeared dialog;
•  go to the Options menu and select the Project settings menu option.

 

Styles list
The list displays styles available in the project. Use the buttons
below the list to add new styles or to delete existing ones.
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Add Style button

 Click this button to add your own style to the list.

Sorting buttons

 Use these buttons to sort the styles in the list.

Remove style button

 Click this button to remove a selected style from the list.

Style properties
In this section you can configure the font settings
(font face, size, color, and decoration) for the
selected or created style.
 

Preview
The preview section shows a
sample text formatted with the
selected style.
 

Import settings
Click this button to import the settings from another project file.
 

OK button

Click this button to save your changes and close the dialog.

Cancel button

 Click this button to cancel your changes and close the dialog.

Help button

 Click this button to show the context help.
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List styles
 

In this dialog you can configure the list styles. You can use these styles to create customized
multilevel lists in the Content editor. To edit the list styles:

• 
 
click the  button to display the project settings and then click Formatting styles in the

appeared dialog;
•  go to the Options menu and select the Project settings menu option.

 

List styles

Use this list to select a style you wish to customize.
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Add \ remove buttons

These buttons allow you to add and remove styles from the list.
 

List level

Use the numbered buttons to select a level of list you want to customize.
 

Type of numbering

Use this drop-down to set the numbering type for a certain list level.

Type of delimiter

Use this drop-down to set the delimiter type for a certain list level.
 

Final delimiter

Use this option to enable or disable the delimiter sign in the end of the number for current
level.

Previous level  concatenation

Uncheck this option if you want to exclude all parent level numberings from current level's
number.
 

Preview

The preview area displays numbering style of all levels at once. Currently selected level is
colored with black. Also, you can click a level you want to customize.
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Import settings

 Click this button to import the settings from another project file.
 

OK button

Click this button to save your changes and close the dialog.
 

Cancel button

 Click this button to cancel your changes and close the dialog.
 

Help button

Click this button to show the context help.
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Collaboration Settings
 

In this dialog you can configure options for Teamwork & Collaboration functionality of the project.
 

•  go to the Options menu and select the Project Settings menu option;

• 
 
click  to display project settings and then click Collaboration in the appeared dialog.

Import settings

Click this button to import the settings from another project file.
 

Auto-commit settings

Use these options to enable/disable automatic commit for Project Tree and Keywords.
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Tiwri account credentials

Use this section to provide your tiwri.com credentials to access your remote repository
with shared projects.

OK button

 Click this button to save your changes and close the dialog.
 

Cancel button

Click this button to cancel your changes and close the dialog.
 

Help button

Click this button to show the context help.
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Keywords
 

If you plan to generate a CHM help file then keep in mind that you can add keywords to create an
index list. Each keyword is assigned to certain pages of the generated help file.

Select a page in the project tree and choose the keywords that you want to link to that page by
selecting the corresponding check boxes next to them. Use the toolbar buttons to add or delete
keywords.

 

Add sibling keyword

 Click this button to add a new keyword at the same level. You can also use the Ins key
to do this.

Add keyword inside

 Click this button to add a sub keyword to the selected one.
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Remove keyword

 Click this button to delete the selected keyword. You can also use the Del key to do
this.

Keyword references

 Click this button to see all the topics assigned to the selected keyword.

Keyword filter

 Click this button to hide/show unrelated (unchecked) keywords.
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Publishing Help Project
 

Publishing your help projects is the final step of help authoring. Once you completed your project,
made all necessary revisions and changes, you can start generating professional help with
Dr.Explain. It allows you to output your help project to the following formats:

•  HTML
•  CHM
•  RTF
•  PDF
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Publishing HTML Help
 
HTML is preferable if your software is platform-independent and users can also open the help file
in their web browsers on any operating system. Storing help files as HTML pages on your website
is also useful when you update your documentation frequently by adding new topics and pages. In
this case, users do not have to download the entire help file after each update.
 
There are several ways to publish your help project to HTML:

• 
 
click  on the application toolbar;

•  go to the Options menu and click the Export to HTML menu option;
•  use the Alt+Shift+L keyboard shortcut.

 
Once you select this option, the following dialog appears:
 

 

Path field
Specify the path to the directory
where Dr.Explain should save the

HTML files. Use the Browse button to browse for the necessary folder.

Validation tool

Select this check box if you want to validate your project files before publishing them.
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Folder cleanup

Check this option to clear the output folder before export. Beware, this function will delete
all files in destination folder.

Automatic publishing

Check this option to upload output files onto your web server automatically via FTP or onto
your Tiwri site.

Index file

Select this check box if you want to add the index file to the
generated HTML files. The index file is usually the starting page of the online manual.

Progress bar
 This bar shows the progress of the publishing process.

Process log
This section shows the log messages of the publishing processes.

Export Options button
Click this button to display the HTML Export Settings dialog where you can
configure the options for the output files.

Browse button
Click this button to browse for the directory where Dr.Explain should save the published
HTML files to.

Once the publishing process is completed you can use the generated files (from the folder you
specified in step 1) to upload them to your website and turn into online help for your application.

Upon completion of the publishing process, Dr.Explain will open the generated HTML help in your
default browser:

http://www.tiwri.com/?ref=help_publish
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The web help layout is responsive and is optimized for small screens of mobile and tablet devices
as well:

 

Open button

Click this button to open target folder in Windows Explorer.

Start/Stop export button
Click this button to start the publishing process. During the publishing process,
this button turns into the Stop export button. Use it when you need to stop the

publishing process and add any changes to your project.

Close button
Click this button to close the Batch export to HTML pages dialog.
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Publishing CHM File
 

CHM file is one of the most convenient ways to deliver your software help in a single indexed file along
with your program. The HTMLhelp API allows for opening a specific topic within the CHM file. Thus,
with CHM you can easily implement context sensitive help functionality in your software application.

 
There are several ways to publish your help project to CHM:

• 
 
click  on the application toolbar;

•  go to the Options menu and click the Export to CHM menu option;
•  use the Alt+Shift+M keyboard shortcut.

 
Once you select this option, the following dialog appears:
 

Open CHM file

 
Clear this check box (it's selected by default) if you don't want to automatically open the
generated CHM file.

Validation tool check

Select this check box if you want to validate your project files before publishing  the CHM file.
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Silently overwrite option

This check box does not appear until you publish your first CHM file. If you select it, you will
skip the Save As dialog next time you generate your CHM file.

Progress bar
This bar shows the progress of the publishing process.

Process log
This section shows the log messages of the publishing processes.

Start/Stop export button
Click this button to start the publishing process. During the publishing process,
this button turns into the Stop export button. Use it when you need to stop the

publishing process and add any changes to your project.

Export options button
Click this button to display the CHM Export Settings dialog where you can configure
the options for the output files.

Close button
Click this button to close the Export to CHM file dialog.

Upon completion of the publishing process, Dr.Explain will open the generated CHM file (if you didn't
clear the corresponding check box):
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Publishing RTF File
 

RTF (Rich Text Format) file is good for printing documentation, while it may look slightly different
in various document readers on different operating systems, specifically graphics and embedded
objects. These formats may be less convenient for complex documents with multiple pages and
objects because of the significant amount of computer memory that is consumed to display them.

 
There are several ways to publish your help project to RTF:

• 
 
click  on the application toolbar;

•  go to the Options menu and click the Export to RTF menu option;
•  use the Alt+Shift+R keyboard shortcut.

 
Once you select this option, the following dialog appears:

 

Open RTF file
Select this check box if you want the application to automatically open the
generated RTF file.

Silently overwrite option

 This check box does not appear until you
publish your first RTF file. If you select it, you will skip the Save As dialog next time you generate
your RTF file.

Progress bar
This bar shows the progress of the publishing process.
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Start export button
Click this button to start the publishing process.

RTF Export Options

 Click this button to display the RTF Export Settings dialog where you can configure
the options for the output files.

Close button
Click this button to close the Export to RTF file dialog.

Upon completion of the publishing process, Dr.Explain will open the generated RTF file (if you didn't
clear the corresponding check box):
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Publishing PDF File
 

PDF (Printable Document Format) is an open standard for document exchange created by Adobe
Systems in 1993. If you need documentation to look the same way in every platform, you can use
PDF format to create printable manuals. PDF files created with the Dr.Explain contain Topic of
Contents (TOC), bookmarks, links, and graphics.
 
There are several ways to publish your help project to PDF:

• 
 
click  on the application toolbar;

•  go to the Options menu and click the Export to PDF menu option;
•  use the Alt+Shift+D keyboard shortcut.

 
Once you select this option, the following dialog appears:

 

Open PDF file

 Select this check box if you want the application to automatically open the
generated PDF file.

Validation tool option

Select this check box if you want to validate your
project files before publishing  the PDF file.

Silently overwrite
 This check box does

not appear until you publish your first PDF file. If you select it, you will skip the Save As
dialog next time you generate your PDF file.



Dr.Explain 4.10 : User Guide Publishing PDF File

Copyright (c) Indigo Byte Systems, LLC 216 of 259

Progress bar
This bar shows the progress of the publishing process.

Process log
This section shows the log messages of the publishing processes.

Start export

 Click this button to start the publishing process.

PDF Export options

 Click this button to display the PDF Export Settings dialog where you can
configure the options for the output files.

Close button

 Click this button to close the Export to PDF file dialog.

Upon completion of the publishing process, Dr.Explain will open the generated PDF file (if you didn't
clear the corresponding check box):
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Teamwork & Collaboration
 
Teamwork & collaboration is the new functionality introduced in Dr.Explain 5.0. The collaboration
feature might be useful not only to team of several writers but to single writers as well.
 
This section describes how multiple Dr.Explain users can work together on the same projects via
Tiwri platform.

http://www.tiwri.com
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Basic principles
 
Teamwork and collaboration is the new functionality introduced in Dr.Explain 5.0. The collaboration
feature might be useful not only to team of several writers but to single writers as well.
 
To start using the collaboration feature you must create an account at tiwri.com (more details about
Tiwri service).
 
As soon as you've created an account at tiwri.com, you're able to create shared projects either via
Tiwri web interface or right in the Dr.Explain application. Then you can share the project with other
users who also have accounts on Tiwri. You can create either a blank project or upload an existing
Dr.Explain project to Tiwri and make it shared.
 
All operations with shared projects are performed in the Dr.Explain application. To modify a certain
element of the project you must perform Edit command. In most cases the Edit command is
performed automatically once you've started editing the element, e.g. start typing in the editor. In
the same moment the element gets locked on the Tiwri server and nobody will be able to modify it
until you commit or revert your changes to Tiwri server.
To see your changes other users must perform Update command in Dr.Explain.
 
To see all the changes in the project use Project History function.
 
Note: to be able to work with Collaboration function in most cases you need active Internet
connection to send and receive data from Tiwri server.
 
The most important teamwork functions and commands are grouped in Collaboration menu.
 

http://tiwri.com
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Tiwri.com
 
Tiwri.com is a cloud web platform that allows Dr.Explain users to work together on the same
projects and to publish their online manuals right from Dr.Explain application.
 
To be able to use this functions you must create an account on tiwri.com platform. Then, you'll
be able to create new shared projects, manage user permissions, and to track user activity.
 
This section shortly describes basic functions of Tiwri service which you can use to work with
shared Dr.Explain projects.

http://www.tiwri.com
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Activity section
 

The Activity section is available in your Tiwri account at http://www.tiwri.com/central/collaboration/
activity
The section shows the changes history for any shared project which you have access to.

 

 
 

Collaboration section menu

Use the menu to navigate across Collaboration sections of your Tiwri account.

http://www.tiwri.com/central/collaboration/activity
http://www.tiwri.com/central/collaboration/activity
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Project changes list

The list displays the commit operations performed in the project in reverse chronological order. There
are Mail-To links near your colleague names, so you can send them email instantly from this page.



Dr.Explain 4.10 : User Guide Activity section

Copyright (c) Indigo Byte Systems, LLC 222 of 259

Filters

Use these options to filter the activity records by project name, by time period, user name.
Click filter fields to add new values.
NOTE: If Documents field is empty no activity records will be shown. Click the field to see
the list of available documents.
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Documents section
 

The Documents section is available in your Tiwri account at http://www.tiwri.com/central/
collaboration/documents
The section lists the shared projects which you have access to. Also you can create a new shared
project in this section.

 

 
 

Collaboration section menu

Use the menu to navigate across Collaboration sections of your Tiwri account.

http://www.tiwri.com/central/collaboration/documents
http://www.tiwri.com/central/collaboration/documents
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Project changes list

The list displays all shared projects you have access to. The project owner names are shown in the
middle column. Use iconic buttons in the right column of the list to manage the projects.

Press  button to see the list of topics in the project.

Press  button to manage the list of users who have access to the project.

Press  button to see the changes history of the project. You can also see the project history
either in Activity section of your Tiwri account or in Dr.Explain application.

Press  button to revoke access to the project. This function is available for projects which are
owned by other users.

Press  button to change the project title and description. This function is available for projects
which are owned by you.

Press  button to remove the project from Tiwri repository. This function is available for projects
which are owned by you.

New document button

Use this button to create a new blank shared document in Tiwri repository. You can also
create a shared project in Dr.Explain application.
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Collaborators section
 

The Collaborators section is available in your Tiwri account at http://www.tiwri.com/central/
collaboration/staff
The section lists all users who have access to the same shared projects which you have to. Also you
can add new collaborators and grant them access to your shared projects in this section.

Please review Tiwri Collaboration: Terms of Use FAQ for more details on how Collaboration module
works.

 
 

http://www.tiwri.com/central/collaboration/staff
http://www.tiwri.com/central/collaboration/staff
http://www.tiwri.com/terms_collaboration
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Collaboration section menu

Use the menu to navigate across Collaboration sections of your Tiwri account.
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Collaborators list

The list displays all users who have access to the same shared projects which you have to.
There are several categories of collaborators:

- users who own some shared documents and who granted access to them
to you.

- users to whom you granted access to your own documents.

- you.
The rest are users who have access to the same documents that you have to, but those
documents aren't owned by you or by those uses.

Please review Tiwri Collaboration: Terms of Use FAQ for more details on how Collaboration
module works.
 
 
Use iconic buttons in the right column of the list to manage the collaborators.

Press  button to see the list of documents you share with the user.

Press  button to see the activity of the user. You can also see the user activity either
in Activity section of your Tiwri account or in Dr.Explain application for a certain project.
 

Press  button to send email to the user. This function is available for Staff users only.

Press  button to deny access to your projects for the user. This function is available for
Staff users only.

http://www.tiwri.com/terms_collaboration
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Add manager button

Use this button to add a new manager to your account.    
 
A manager is another Tiwri user, usually a member of your team, who can be entitled
by you to manage documents in your account (that is, to create, delete, and share
documents). A manager is not allowed to switch your account to another Tiwri plan, or
to access your account settings or billing settings. To assign a manager, you must be
subscribed to a paid plan. Please review Tiwri Collaboration: Terms of Use FAQ for more
details on how Collaboration module works.
 
The following dialog will appear.

You can either enter a user email address or press  button to choose an existing
user from the list.

Add staff button

Use this button to grant access to your project to a new user. The following dialog will
appear.

You can either enter a user email address or press  button to choose an existing
user from the list.
 

http://www.tiwri.com/terms_collaboration
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Settings section
 

The Settings section is available in your Tiwri account at http://www.tiwri.com/central/collaboration/
settings
The section allows to set and customize your Tiwri Collaboration service plan.
Please review Tiwri Collaboration: Terms of Use FAQ for more details on how Collaboration module
works.

 

http://www.tiwri.com/central/collaboration/settings
http://www.tiwri.com/central/collaboration/settings
http://www.tiwri.com/terms_collaboration
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Collaboration section menu

Use the menu to navigate across Collaboration sections of your Tiwri account.

Service plan

The section displays the current service plan for your Tiwri Collaboration module.

The icons show how many staff users and shared documents are allowed for
the current plan.
 

Press  button to change the plan settings. The following dialog will appear.

Here you can add extra staff users or extra documents to your service plan package.
Please review Tiwri Collaboration: Terms of Use FAQ for more details on how
Collaboration module works.
 

http://www.tiwri.com/terms_collaboration
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Choose plan button

Use this button to set another service plan for your Tiwri Collaboration module.
 
The following dialog will appear.

Please review Tiwri Collaboration: Terms of Use FAQ for more details on how Collaboration
module works.

http://www.tiwri.com/terms_collaboration
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Creating a shared project
 
There are several ways to create a new blank shared project:

• 
 
In your account on tiwri.com server press  button in Documents

section.
•  In the Dr.Explain application use command Create a shared project on tiwri.com either
in Startup Dialog or in File menu.

 
Also, you can create a shared project from an exiting Dr.Explain local project. Open your local file

in Dr.Explain and press   button in the main toolbar or use Upload command in Collaboration
menu.

 
In all cases, the following dialog will appear.
 

http://tiwri.com
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Tiwri account credentials

Please provide here your Tiwri account login and password to connect to your project
repository.

Connection status

The connection status line displays informational messages about your connection status
or errors.

Project owner

Use this drop-down list to assign the project owner role either to yourself or to someone
who made you a manager in his/her Tiwri account. Read more about managing user
rights.

Project name

Specify the project name here. Later, you can change it in Documents section in your Tiwri
account.

User permissions

Use this section to set a permission type for each collaborator. Simply click the color
box to set a certain permission type. You can add new collaborators and also change
permissions in Documents section in your Tiwri account.

Local copy destination

Use this box to specify a file where local copy of the project will be stored.
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Assigning users to a shared project
 
Initially, you can grant permissions to view or edit you shared project to other users when you are
creating a new shared project.
 
Also, you can add new collaborators and change their rights in the Documents section of your
tiwri.com account.

http://www.tiwri.com
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Opening a shared project (Checkout)
 

Note: use Checkout function only when you're wishing to start working with the new shared project
and if you have no local copy of it. If you already have a local copy of a shared project then simply
open it as a usual Dr.Explain project.
 
There are two ways to open (checkout) a shared project:

•  use Checkout project from tiwri.com item in Startup Dialog;
•  use Checkout project from tiwri.com command in File menu.

 
The following dialog will appear:

 

Tiwri account credentials

Please provide here your Tiwri account login and password to connect to your project
repository. Then press Connect button to load the list of available projects from your Tiwri
repository.
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Connection status

The connection status line displays informational messages about your connection status
or errors.

Remote project list

Once the connection to your Tiwri account is established the list of available projects will
be loaded and shown. To open a certain project either double click on it or select its radio
button and press OK.

Choose a place for local copy

Use this box to specify a file where local copy of the project will be stored.
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Receiving project updates
 
To see the shared project's changes made by other users you must perform Update command for
your local copy.
 
Also, the project update is performed automatically when any changes are committed to the
server. Moreover, if you are going to edit an element which was modified by another user you will
be asked to perform project update as well.
 
In addition, there are two ways to perform project update manually:

• 
 
press  button in the main toolbar or press F5 key;

•  use Update All command in Collaboration menu.
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Editing remote project's elements
 

Use Edit command to start modifying elements in a shared project. In most cases the Edit
command is performed automatically once you've started editing the element, e.g. start typing in
the editor.
In the same moment the edited elements get locked on the Tiwri server and nobody will be able to
modify them until you commit or revert your changes to Tiwri server.
 
To perform the Edit command for a certain topic click  icon in the project tree near the topic's
node or use Edit this element command in the popup menu.
 
To edit all topics in a project tree's branch please use Edit sub-elements... command in the popup
menu of the branch's parent topic.
To start edit entire project (and to lock all its topics on server) use Edit... command in
Collaboration menu. The following dialog will appear.

 

 
In the dialog, please uncheck the elements you do not want to edit and press OK.
 
To edit non-topic project elements, such as Keywords, Project Tree or Project Settings use Edit
only submenu in Collaboration menu.
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Committing changes
 

To merge your local changes with the shared project you must Commit your changes to the
server. So, other users will see your modifications once they perform Update operation for their
local copies. To send your changes to the server please click  icon near the topic node in the
Project Tree. Also, you can use Commit this element command in the popup menu of the
element.
 
Moreover, you can send to the server changes of a topic and of all its nesting topics with Commit
sub-elements... command in the popup menu of the element.
 

To commit all project modifications use  button in the application toolbar, or Commit...
command in Collaboration menu, or press F8 key. The following dialog will appear.

 

Elements to commit

Uncheck project elements which you do not want to commit.
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Commit message

Type in an optional commit message. This text will be shown in Project changes history
and Activity section for this project.

 
To commit changes of non-topic project elements, such as Keywords, Project Tree or Project
Settings use Commit only submenu of Collaboration menu.
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Auto-commit
 
By default, the modifications made in the Project Tree and Keywords Tree are committed to the
server automatically after 5 minutes since the last modification. If the Project Tree has been

modified the  icon will appear in the right bottom corner of the project tree panel. Position the
mouse cursor over the icon to see how much time remains until auto-commit.
 

To cancel the automatic commit for a particular time click  icon and select Do not auto-commit
this time command in the popup menu. To completely disable auto-commit for current project use
Collaboration section in the Project Settings dialog.
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Reverting changes
 

To discard changes made in a shared project use Revert command. To discard modifications of a
certain topic use Revert this element command in the popup menu of this element.
 
To discard changes of a certain topic and of its nesting topics use Revert sub-elements...
command in the popup menu of this element.
To discard all changes made in the project use Revert... command in Collaboration menu. The
following dialog will appear.

 

 
In the dialog, please deselect the elements you do not want to revert and press OK.
 
To discard changes of non-topic project elements, such as Keywords, Project Tree or Project
Settings use Revert only submenu in Collaboration menu.
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Project changes history
 

To see all changes (commits) made in a shared project use Project history command in
Collaboration menu. The following dialog will appear.

 
 

Filters

Use these options to filter the project history records by time period, user name, topic
name, or commit message.
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Project history records

The list displays the commit operations performed in the project in reverse chronological
order. Select a record to see the details of a particular commit.

Commit details

Select a particular commit record in changes list to see the project elements that were
actually modified then.
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Detaching a shared project from server
 
To detach a shared project from tiwri.com server use Detach this project copy from server
command in Collaboration menu.
 
Detaching means that the project file will be permanently unlinked from the server and will be
saved as a local project with no changes history and no server connection settings. All future
changes will be saved in the local file only and won't be synchronized with the server copy.
 
 

http%3b//www.tiwri.com
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Local copy of a shared project
 
A local copy is a Dr.Explain project file in .GUI format which is created on local PC during checking
out a shared project from tiwri.com. Also, if you upload an existing local project to Tiwri server, the
original source file became a local copy of the newly created shared project.
 
A local copy stores all cached data about associated shared project and allows Dr.Explain not
to download all data from server every time you start working with the project. Also, a local copy
stores connection settings and all your changes which have not been yet committed to server.
 
The path to local copy can be set in Checkout and Create a new shared project dialogs.
 
To create a second local copy you must Checkout a shared project from server once again and set
another file name for it. Note: creating several local copies of the same shared project is a tricky
approach which is not recommended. There might be conflicts if you have not committed changes
in different local copies of the same shared project on one PC.

http://www.tiwri.com
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Advanced Practices
 

The topics in this chapter contain explanations of some advanced actions in Dr.Explain. They are
useful for software developers and advanced users.
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Using Command Line Commands
 

This feature is useful for the batch processing of numerous projects or for script-based automation.
The command line mode allows exporting .GUI projects into the HTML, CHM, PDF or RTF format
without displaying application windows.

To be able to use the command line commands, you need to use the special executable: <Program
Files>\Dr.Explain\tools\deexport.exe

Command line syntax is:

HTML export:
deexport.exe filename.gui /sh [output folder]

CHM  export:
deexport.exe filename.gui /sc [file.chm] [temp folder]

RTF  export:
deexport.exe filename.gui /sr [file.rtf]

PDF  export:
deexport.exe filename.gui /sp [file.pdf]

In case of errors or warnings the messages are written in the console.
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Compacting Tool
 

The Compacting Tool is a useful tool for compressing your project by removing all inactive
elements at once: pages, topics, controls. On large projects this will significantly increase the
performance of your work and save disk space. In the settings, you can configure what kind of
inactive elements must be removed from the project.
 
To compact your project, you can either go to the Tools menu and select the Compacting Tool menu
option or use the Alt+Shift+C keyboard shortcut. Once you select this option, Dr.Explain displays
the following dialog:

Inactive controls removing

Select this check box if you want to remove all inactive controls from the project screenshots.

Inactive pages removing

Select this check box if you want to remove inactive pages from your current project. These
are pages which are not exported to any format.

Active sub-pages keeping

Select this check box if you want to keep inactive pages that have active subpages.

Compact button

 Click this button to start compacting your project.



Dr.Explain 4.10 : User Guide Compacting Tool

Copyright (c) Indigo Byte Systems, LLC 250 of 259

Cancel button

 Click this button to cancel the compacting process and close the dialog.
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Validation Tool

The Validation Tool is one of the advanced functions of Dr.Explain.

The Validation Tool searches through your project files to find different types of errors and warnings
such as:

1.  Duplicated topic/page names.
2.  Broken links.
3.  Unlinked keywords.
4.  Missed topic/page names.
5.  Missed or invalid Alias/Help ID values.
6.  Duplicated Alias/Help ID values.

To validate files in your project, you can either go to the Tools menu and select the Validation
Tool menu option or use the Alt+Shift+J keyboard shortcut. Once you select this option, Dr.Explain
displays the following dialog:
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Errors and Warnings groups

 The displayed tabs contain a list of the
corresponding errors and warnings found in your project sorted by their severity.

Issues list
This list shows actual errors and warnings of the certain type. See the hint below the list to
know how to fix them.

 
 

Hint

 Dr.Explain displays hints that explain how to fix found
errors and warnings.

Recheck button
Click this button to check your project again to verify that you have fixed the
issues.

OK button
Click this button to save your changes and close the dialog.

Cancel button
Click this button to discard your changes and close the dialog.

Options button
Click this button to configure what type of errors the Validation Tool should be
searching for when validating your project.

Possible values are:
•  Check for no topic/page name.
•  Check for broken links.
•  Check for unlinked keywords.
•  Check for Help ID errors.
•  Run the validation tool before exporting.
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Exporting Sitemap and Sitemap Index
 

A sitemap is a list of pages of a website, usually organized in a hierarchical manner. It helps users
and search engines find pages on the site. The sitemap file helps search engine spiders properly
index your help pages. That will make your help pages appear in the search engine database
much faster.
 
A sitemap index is an XML file that lists multiple XML or RSS sitemap files. Most often it is an A-
Z index that provides access to particular content, while a sitemap represents a general top-down
overview of the whole site contents.
 
To export a sitemap go to the Tools menu and select the Export sitemap menu option. Dr.Explain
will open a pop-up dialog asking for the location and name of the sitemap file and then create and
save the sitemap file in the specified location.
 
To export the sitemap index, go to the Tools menu and select the Export sitemap index menu
option. Dr.Explain will then automatically create a sitemap index for your help pages.
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Help ID
 

With Dr.Explain you can assign the numerical Help ID values and text aliases to every help topic
and later on use them for implementing context sensitive help file for your software application.
 
Then, you can create a map file to include it in your software source code. Dr.Explain can generate
Help ID map files in four common formats:

.h (C++ header file),

.vb (Visual Basic map file),

.cs (C# source code file),

.inc (Object Pascal & Delphi file).
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Keyboard Shortcuts
 
The following section lists all available keyboard shortcuts and mouse controls that you can use
when working with Dr.Explain.
 
•  General

F1 — display context help.
Ctrl+N — create new project.
Ctrl+O — open project.
Ctrl+S — save open project.
Ctrl+Shift+O — open shared project from tiwri.com.
Ctrl+Alt+P — open project options.

 
•  Topics

Ctrl+T — add child topic.
Ctrl+D — add topic at the same level.
Ctrl+W — add child topic with screenshot.
Ctrl+Q — add topic with screenshot at the same level.
Alt+Shift+I — import external files as topics.

 
•  Search

Ctrl+F — find.
Ctrl+H — find and replace.
F3 — find next.

 
•  Export

Alt+Shift+L — export to HTML.
Alt+Shift+D — export to PDF.
Alt+Shift+R — export to RTF.
Alt+Shift+M — export to CHM.

 
•  Project Tree

F4 — switch to Text Editor.
Ctrl+Down — move topic one position below.
Ctrl+Up — move topic one position up.
F2 — rename topic.
Ctrl+Delete — deletes topic.
Delete — hide/show topic.

 
•  Editing

Alt+BackSpace — undo.
Shift+Delete — cut.
Shift+Insert — paste.
Ctrl+C — copy.
Ctrl+Insert — copy.
Ctrl+X — cut.
Ctrl+V — paste.
Ctrl+Y — redo.
Ctrl+A — select all.
Ctrl+Z — undo.
Ctrl+Shift+Z — redo.
Shift+Alt+BackSpace — redo.
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•  Text Editor
F4 — switch to Project Tree.
Ctrl+B — bold text.
Ctrl+I — italic text.
Ctrl+U — underline text.
 
Ctrl+= — subscript.
Ctrl+Shift+= — superscript.
Alt+Ctrl+1 — apply Heading 1 style.
Alt+Ctrl+2 — apply Heading 2 style.
Alt+Ctrl+3 — apply Code style.
Alt+Ctrl+4 — apply Quote style.
Ctrl+Shift+N — apply Normal style.
Alt+Ctrl+5 — apply User defined style 1.
....
Alt+Ctrl+0 — apply User defined style 6.
 
Ctrl+E — align center.
Ctrl+J — justify text.
Ctrl+L — align left.
Ctrl+R — align right.
 
Ctrl+K — insert hyperlink.
Ctrl+Shift+P — insert image.
Ctrl+Shift+T — insert table.
Ctrl+Shift+V — insert video.
Ctrl+Shift+R — insert variable.
Ctrl+Shift+S — insert HTML code.
Ctrl+Shift+H — insert horizontal line.
Ctrl+Shift+B — insert page break.
Ctrl+Shift+L — insert plain list.
Ctrl+Alt+L — insert numbered list.
 
Ctrl+Alt+C — insert © symbol.
Ctrl+Alt+R — insert ® symbol.
Ctrl+Alt+T — insert ™ symbol.
 
Shift+Tab — decrease level, if pressed in the beginning of paragraph.
Ctrl+Shift+M — move left.
Ctrl+M — move right.
 
Shift+Enter — insert line break.
Ctrl+Enter — inside text: insert page break; inside table: add new row below.
Ctrl+Shift+Enter — split topic or create a new topic from selected text.
 

 
•  Tools

Alt+Shift+C — start Compacting Tool.
Alt+Shift+J — start Validation Tool.
 

•  Keywords
Insert — add a keyword on the same level.
Alt+Insert — add a subkeyword.
Delete — delete a keyword with all subkeywords.
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•  Collaboration

F8 — for local projects: upload project to tiwri.com; for shared projects: commit items to
server.
F5 — update project from server.
 

•  Additional mouse controls
Ctrl+Click link — navigate to the hyperlink.
In Designer mode: if you press and hold Alt when dragging a control rectangle, then
pointer tail will move independently of the rectangle.
In Designer mode: if you press and hold Shift when moving a pointer with an Arrow key,
you can move only its tail.
In Designer mode: hold Shift key while dragging bullet mark to snap bullet line to angles
multiple of 15 degrees.
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Troubleshooting
 

I cannot open my .GUI project file.

Do you have a *.gui.bak file next to the project file? Rename it to *.gui (i.e. remove the .bak
extension) and try to open it again. This is a backup copy of the last saved version of your project
file.
If this doesn’t work, please send your .GUI project file to our developers for investigation.
 
 
I cannot generate a CHM file. I see MSHHWC errors in the export log.

To be able to generate CHM files, please make sure that you have specified the path to HTML
Help Workshop (HHWS) in the Project settings -> CHM Export -> CHM Compiler Dialog.
The default directory is "C:\Program Files\HTML Help Workshop".
If you don't have Microsoft HTML Help Workshop installed on your computer, then download it
from the Microsoft website (free): http://msdn.microsoft.com/en-us/library/ms669985.aspx
 
 
The application doesn’t accept my license key.

You must enter the license key as a single line.
Please check if  ...

•  #1. ... you entered the registration data without trailing and leading spaces.
•  #2. ... you entered the full registration key and it ends with the = character.
 

If this doesn't help, please send us a screenshot of your registration screen with the registration
info.
 
 
When I open a CHM file I see the table of contents but the main content area displays an
error.

This is a common issue related to Windows security policy regarding CHM files. It is not a
Dr.Explain problem. Please read more about it in the article on our site:
http://www.drexplain.com/press/chm-files-the-page-cannot-be-displayed-error/
This often happens when users try to open a CHM file either from a remote location or right from
the folder where they have just downloaded it (it must be moved into another folder first).
 
 
Search function doesn’t work in my local HTML help in the Chrome web browser.

This is a known issue of Google Chrome. It blocks AJAX requests for local files (file:///C:/Help/....).
AJAX requests are used for search & index to dynamically load search results and a keyword list.
Therefore, either use another browser (Firefox, Opera, or IE) to preview local files or upload them
to a web host and open in Chrome via HTTP protocol (e.g. http://localhost/help/...).
 
 
How do you remove the “Made by Dr.Explain” link?

To hide the Dr.Explain link in HTML/CHM:
1. Click the Project Settings tool button.
2. Select the HTML (CHM) Export section

http://msdn.microsoft.com/en-us/library/ms669985.aspx
http://www.drexplain.com/press/chm-files-the-page-cannot-be-displayed-error/
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3. Click the HTML Template & Layout -> Setup button.
4. Click the Navigation Bar section in the left part of the dialog.

5. Select Hide the Dr.Explain link check box in the right part of the dialog.

6. Click OK and then OK once more.
 
 
HtmlHelp API call raises "HH_HELP_CONTEXT called without a [MAP] section" error.

This is a known issue of HtmlHelp API. You must set valid alias for topic you're trying to open by
its Help ID number. Alias can be set in Topic Properties.
 
 
Additional resources with FAQ and troubleshooting:
 
http://www.drexplain.com/forum/viewforum.php?f=5
http://www.drexplain.com/ordering_faq/

http://www.drexplain.com/forum/viewforum.php?f=5
http://www.drexplain.com/ordering_faq/
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